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ABSTRAK

MEDIA PEMBELAJARAN MICROSOFT EXCEL
BERBASIS MULTIMEDIA
DI SMA NEGERI 1 NGEMPLAK

Oleh :

Agus Buchori
07520244036

Tujuan penelitian ini adalah untuk menghasilkan produk berupa media
pembelajaran mata pelajaran Microsoft Excel yang telah diuji sebagai pendukung
proses pembelajaran teknologi informasi dan komunikasi. Kemudian menguji
kelayakan media yang telah dibuat untuk pembelajaran teknologi informasi dan
komunikasi di SMA Negeri 1 Ngemplak.

Penelitian ini termasuk penelitian pengembangan (Research and
Development). Adapun langkah-langkah penelitian yaitu : kompetensi, potensi
masalah, analisis kebutuhan, desain implementasi, produk, validasi ahli, revisi
produk, ujicoba pemakaian, revisi produk, produk masal. Respon ujicoba 97
siswa, yaitu 19 siswa untuk ujicoba instrumen dan 78 untuk ujicoba lapangan.
Pengumpulan data dilakukan dengan observasi dan dokumentasi. Adapun metode
yang digunakan untuk menganalisis data adalah dengan teknik analisis deskriptif
kuantitatif yang diungkapkan dalam distribusi skor dan dipersentase terhadap
kategori skala penilaian yang telah ditentukan.

Hasil analisis menunjukkan bahwa kualitas produk yang dihasilkan adalah
sebagai berikut dari uji kelayakan yang dikembangkan media pembelajaran
menurut ahli materi memperoleh persentase sebesar 81,25 % termasuk dalam
kategori sangat baik, menurut ahli media memperoleh persentase sebesar 70 %
termasuk dalam kategori baik. Menurut siswa memperoleh persentasi sebesar
83,56 % termasuk dalam kategori sangat baik. Dengan demikian dapat
disimpulkan bahwa media pembelajaran memiliki kualitas sangat baik untuk
mendukung pembelajaran teknologi informasi dan komunikasi yaitu Microsoft
Excel.

Kata kunci : media pembelajaran, pengembangan, Microsoft Excel



MOTTO

% Hidup adalah perjuangan tiada henti.

% Jangan pernah taRut untuk mencoba, Rarena segala sesuatu hal berawal dari
mencoba sampai akhirnya Anda sendiri yang menilai apakah Anda sudah mampu
dalam bidang tersebut atau belum. Selain itu, dengan banyak mencoba Anda akan
semakin tertempa untuk mampu menyelesaikan segala macam masalah yang Anda
hadapi dalam bidang tersebut.

¢ Tanyakan kepada orang yang lebih berpengalaman Rarena hal itu akan menambah
wawasan serta informasi yang Rita butuhRan dalam memulai satu pekerjaan.

% Mulailah menggarap sedikit demi sedikit ide yang ada dalam pikiran Anda, jangan

Jjadikan ide tersebut hanya sebatas wacana.
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BAB |

PENDAHULUAN

A. Latar Belakang Masalah

Media pembelajaran adalah bahan, alat, atau teknik yang digunakan dalam
kegiatan belajar mengajar dengan maksud agar proses interaksi komunikasi
pembelajaran antara guru dan siswa dapat berlangsung dengan baik. Berdasarkan
definisi tersebut, media pembelajaran memiliki manfaat yang besar dalam
memudahkan siswa mempelajari materi pelajaran. Media pembelajaran yang
digunakan harus dapat menarik perhatian siswa pada kegiatan belajar mengajar
dan lebih merangsang kegiatan belajar siswa. Dari definisi tersebut media
pembelajaran memiliki manfaat yang besar dalam memudahkan siswa untuk
mempelajari materi pelajaran.

Menurut Kemp Dayton (1985) Media pembelajaran yang digunakan harus
dapat menarik perhatian siswa pada kegiatan belajar mengajar dan lebih
merangsang kegiatan belajar siswa, media pembelajaran mempunyai fungsi untuk
memperjelas penyajian pesan agar tidak terlalu bersifat verbalistis (dalam bentuk
kata-kata tertulis atau lisan belaka), mengatasi keterbatasan ruang, waktu, dan
daya indera, Dengan menggunakan media pendidikan secara tepat dan bervariasi
dapat diatasi sikap pasif anak didik. Sifat yang unik pada setiap siswa ditambah
lagi dengan lingkungan dan pengalaman yang berbeda, sedangkan kurikulum dan
materi pendidikan ditentukan sama untuk setiap siswa, maka guru akan banyak

mengalami kesulitan apabila semuanya itu harus diatasi sendiri. Apalagi bila latar



belakang lingkungan guru dengan siswa juga berbeda. Masalah ini dapat diatasi
dengan media pendidikan, nampak jelas bahwa media pembelajaran mempunyai
andil yang besar terhadap kesuksesan proses belajar mengajar.

Microsoft Excel adalah program aplikasi pada microsoft office yang
digunakan dalam pengolahan angka (Aritmatika). Program ini sering digunakan
oleh para akuntan untuk menuliskan atau mencatat pengeluaran dan pemasukan
didalam perusahaan atau suatu lembaga maupun instansi-instansi kecil. Banyak
para akuntan yang mengerti dan bisa mengoprasikan program ini tapi bukan hanya
seorang akuntan saja yang bisa, bahkan anak SMA pun juga bisa mengoprasikan
program ini, karena dibangku SMA telah mempelajari tentang microsoft excel.

Fasilitas pembelajaran di SMA Negeri 1 Ngemplak telah mendukung
kinerja guru untuk menyampaikan materi pembelajaran seperti laboratorium
komputer, LCD viewer projector, white board, akan tetapi fasilitas tersebut belum
digunakan secara maksimal oleh guru untuk menyampaikan isi pelajaran pada
peserta didik. Guru menyampaikan isi pelajaran dengan fasilitas aplikasi microsoft
power point yang kurang menarik serta kurang adanya interaksi ke peserta didik.
Kesulitan yang dialami oleh siswa SMA Negeri 1 Ngemplak untuk menggunakan
microsoft excel adalah siswa tidak bisa menggunakan rumus pada microsoft excel,
pemahaman relatif lama (waktu pelajaran habis untuk memahami microsoft excel)
dengan menggunakan ceramah dari guru sehingga materi tidak tuntas,
pemahaman setiap siswa berbeda sehingga materi setiap kelas berbeda. Selama ini
media yang digunakan untuk pembelajaran hanya sebatas buku-buku yang

dipinjam diperpustakaan, lembar kerja siswa LKS dan ceramah, kurangnya



kreatifitas guru untuk memaksimalkan fasilitas media untuk menggunakan media
animasi yang mendukung proses pembelajaran microsoft excel.

Peran media pembelajaran menjadi sangat penting didalam strategi
pembelajaran sebagai alat bantu mengajar yang turut mempengruhi situasi,
kondisi, dan lingkungan belajar yang direncanakan, dipersiapkan dan diciptakan
olenh guru. Penggunaan media dalam proses pembelajaran dapat minat dan
semangat yang baru, membangkitkan motivasi dan rangsangan kegiatan belajar
dan bahkan membawa pengaruh-pengaruh psikologis terhadap siswa. Selain
membangkitkan motivasi dan minat siswa, media pembelajaran juga dapat
membantu siswa meningkatkan pemahaman, menyajikan data dengan menarik.

Dengan adanya media pembelajaran microsoft excel berbasis multimedia
dapat mempermudah peserta didik untuk mempelajari microsoft excel,
menyediakan tutorial yang tidak mudah didapat melalui materi-materi yang lain
dan menjadikan proses belajar mendalam dan beragam. Berdasarkan latar
belakang peneliti bermaksud membuat media pembelajaran microsoft excel

berbasis multimedia di SMA Negeri 1 Ngemplak.

B. Identifikasi Masalah

Berdasarkan uraian yang telah dipaparkan pada latar belakang masalah,
maka dapat diidentifikasi sejumlah permasalahan yang muncul antara lain :
1. Selama ini media pembelajaran yang digunakan oleh guru kurang menarik

sehingga terkadang siswa merasa jenuh atau bosan.



2. Belum adanya media pembelajaran berupa adobe flash yang dapat digunakan
mendukung proses belajar mengajar yang menarik dengan menggunakan
teknologi animasi.

3. Belum maksimalnya penggunaan fasilitas pendukung pembelajaran yang
tersedia di sekolah sebagai media pembelajaran dari pihak guru.

4. Materi microsoft excel lebih banyak menggunakan media buku-buku teks
dengan kalimat yang bersifat verbal sehingga siswa kurang mendapatkan

penggambaran tentang materi tersebut.

C. Batasan Masalah

Berdasarkan beberapa pokok permasalahan yang telah diuraikan pada
identifikasi masalah di atas, permasalahan dibatasi pada merancang dan menguiji
kelayakan media microsoft excel berbasis multimedia. Multimedia disusun terdiri
dari teks, animasi, gambar, video, musik instrumen, dilengkapi dengan umpan
balik hasil belajar berupa evaluasi yang menggunakan extensible markup
language (XML). Perancangan multimedianya menggunakan program-program
multimedia editor yaitu : Adobe Flash CS3 menggunakan Action Script,
Photoshop cs 3 dan Corel draw x3.

Materi microsoft excel dalam media ini adalah materi dasar, yang
disesuikan dengan kurikulum Teknologi Informasi dan Komunikasi (TIK) telah
ditetapkan secara nasional. Kurikulum tersebut terdiri atas standar kompetensi dan
kompetensi dasar. Standar kompetensi dan kompetensi dasar menjadi arah dan

landasan untuk mengembangkan materi pokok, kegiatan pembelajaran, dan



indikator pencapaian kompetensi untuk penilaian. Standar kompetensi TIK untuk

Kelas XI semester genap adalah menggunakan perangkat lunak pengolah angka

untuk menyajikan informasi. Standar kompetensi tersebut memuat tiga

kompetensi dasar, yaitu:

1. Menggunakan menu dan ikon yang terdapat dalam perangkat lunak pengolah
angka.

2. Membuat dokumen pengolah angka dengan variasi teks, tabel, grafik, gambar,
dan diagram.

3. Mengolah dokumen pengolah angka dengan variasi teks, tabel, grafik, gambar,

dan diagram untuk menghasilkan informasi.

D. Perumusan Masalah
Berdasarkan uraian di atas, dapat dirumuskan permasalahan penelitian ini,
yaitu
1. Bagaimana pembuatan media pembelajaran microsoft excel berbasis
multimedia?
2. Bagaimana kelayakan media pembelajaran microsoft excel berbasis
multimedia?
E. Tujuan Penelitian
Tujuan dari penelitian yang dilaksanakan adalah untuk:
1. Pembuatan media pembelajaran microsoft excel berbasis multimedia.
2. Menguji kelayakan media media pembelajaran microsoft excel berbasis

multimedia.



F. Kegunaan Penelitian
1. Bagi Siswa
Manfaat yang dapat diperoleh dari media pembelajaran microsoft excel
berbasis multimedia bagi siswa antara lain:
a. Memberikan kemudahan bagi siswa untuk mempelajari microsoft excel
yang disertai visualisasi materi.
b. Dapat meningkatkan kualitas hasil belajar siswa melalui penerapan
media pembelajaran microsoft excel.
c. Memberikan alat evaluasi bagi siswa untuk mengetahui sejauh mana
siswa memahami materi microsoft excel.
2. Bagi Pengajar
Manfaat yang dapat diperoleh dari media pembelajaran microsoft excel
berbasis multimedia bagi guru antara lain:
a. Sebagai alternatif media pengajaran untuk menyampaikan materi
microsoft excel.
b. Sebagai alat atau bahan untuk mengevaluasi pemahaman siswa
terhadap materi microsoft excel.
3. Bagi Pengembang lImu
Manfaat yang dapat diperoleh dari media pembelajaran microsoft excel
berbasis multimedia bagi pengembang ilmu antara lain:
a. Dihasilkan CD pembelajaran microsoft excel yang dapat dijadikan

variasi pembelajaran dan meningkatkan kreativitas pengajar.



b. Hasil penelitian ini diharapkan dapat diterapkan pada dunia pendidikan
dan disiplin ilmu yang lain untuk membuat media pembelajaran
menggunakan bantuan komputer.

c. Dapat mengembangkan pengetahuan dan pengalaman serta

meningkatkan motivasi untuk terus belajar.
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KAJIAN PUSTAKA

A. Media Pembelajaran
1. Pengertian Pembelajaran

Pendidikan tidak lepas dari pembelajaran, keterkaitan yang sangat
erat dan tidak dapat dipisahkan satu sama lain dalam proses pendidikan.
merupakan setiap upaya yang dilakukan dengan sengaja oleh pendidik
yang dapat menyebabkan peserta didik melakukan kegiatan belajar.

Pembelajaran sesungguhnya merupakan kegiatan yang dilakukan
untuk menciptakan suasana atau memberikan pelayanan agar siswa
belajar. Oleh sebab itu, harus dipahami bahwa bagaimana siswa
memperoleh pengetahuan dari kegiatan belajarnya. Jika guru dapat
memahami proses perolehan pengetahuan, maka guru akan dapat
menentukan strategi pembelajaran yang tepat bagi siswanya (Sugihartono,
2007: 73).

Pendidikan berasal dari kata didik, mendidik berarti memelihara
dan membentuk latihan. Dalam kamus besar bahasa Indonesia (1991)
Pendidikan diartikan sebagai proses pengubahan sikap dan prilaku
seseorang atau sekelompok orang dalam usaha untuk mendewasakan

manusia melalui upaya pengajaran dan pelatihan.



Pendidikan merupakan usaha secara sengaja dari seseorang untuk
meningkatkan kedewasaan yang selalu diartikan sebagai kemampuan
untuk bertanggung jawab terhadap segala perbuatan.

Definisi tersebut diatas dapat disimpulkan bahwa pendidikan
adalah suatu usaha yang dilakukan secara sadar dan sengaja untuk
mengubah tingkah laku manusia yang baik secara utuh (Sugihartono,
2007: 3).

Media Pembelajaran

Kata media berasal dari bahasa latin medium yang secaa harafiah
berarti tengah, perantara atau pengantar. Media apabila dipahami secara
mendalam adalah manusia, materi, kondisi yang membuat siswa mampu
memperoleh pengetahuan, keterampilan atau sikap. Secara khusus
pengertian media dalam proses belajar mengajar lebih cenderung diartikan
sebagai alat tulis grafis, fotografis, atau elektronik untuk menangkap,
memproses, dan menyusun kembali informasi visual atau verbal (Azhar
Arsyad, 1997: 3).

Media adalah sebuah alat yang mempunyai fungsi untuk
menyampaikan pesan pembelajaran. Pembelajaran dapat diartikan sebagai
sebuah proses komunikasi antara peserta didik (pembelajar), pengajar dan
bahan ajar. Komunikasi tidak akan berjalan tanpa bantuan sarana
penyampai pesan atau media. Berbagai bentuk stimulus bisa dipergunakan
sebagai media diantaranya adalah hubungan atau interaksi manusia,

realita, gambar diam atau bergerak, tulisan dan suara yang direkam.



10

Kelima bentuk stimulus ini akan membantu pembelajar dalam

mempelajari materi. Namun demikian tidaklah mudah mendapatkan

kelima bentuk itu dalam satu waktu dan tempat. Dasar dipertimbangkan

dalam pemilihan suatu media adalah sebagai berikut:

a. Ingin mendemonstrasikannya seperti halnya pada kuliah tentang
media.

b. Merasa sudah akrab dengan media tersebut, misalnya seorang guru
yang sudah terbiasa menggunakan proyektor.

c. Ingin memberi penjelasan yang lebih konkrit.

d. Dan bahwa media dapat berbuat lebih dari yang bisa dilakukannya,
misalnya untuk menarik minat gairah belajar siswa,

Jadi pada dasarnya pertimbangan untuk memilih suatu media
sangatlah sederhana, yaitu memenuhi kebutuhan atau mencapai tujuan
yang diinginkan (Sadiman, 2006: 83-84).

Pentingnya media dalam sebuah pembelajaran, sebelumnya kita
harus mengetahui terlebih dahulu konsep abstrak dan konkrit dalam
pembelajaran. Karena pada hakekatnya proses belajar mengajar adalah
proses komunikasi, penyampaian pesan dari pengantar ke penerima. Pesan
tersebut berupa isi atau ajaran yang dituangkan ke dalam simbol simbol
komunikasi baik verbal (kata-kata dan tulisan) maupun nonverbal, proses
ini dinamakan decoding.

Didalam penafsiran tersebut ada kalanya berhasil dan ada kalanya

tidak berhasil atau gagal. Dengan kata lain dapat dikatakan
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kegagalan/ketidakberhasilan dalam memehami apa yang didengar, dibaca,

dilihat atau diamati. Kegagalan itu disebabkan oleh gangguan yang

menjadi penghambat komunikasi yang dalam proses komunikasi dikenal
dengan istilah barriers atau noise. Semakin banyak verbalisme semakin
abstrak pemahaman yang diterima.

Secara umum dapat dikatakan media mempunyai kegunaan, antara
lain :

a. Memperjelas pesan agar tidak terlalu verbalistis.

b. Mengatasi keterbatasan ruang, waktu, tenaga, dan daya indra.

c. Menimbulkan gairah belajar, interaksi lebih langsung antara siswa
dengan sumber belajar.

d. Memungkinkan anak belajar mandiri sesuai dangan bakat dan
kemampuan visual, auditori dan kinestetiknya.

e. Memberi rangsangan yang sama, mempersamakan pengalaman dan
menimbulkan persepsi yang sama.

f. Proses pembelajaran mengandung lima komponen komunikasi guru
(sebagai komunikator), bahan pembelajaran, media pembelajaran,
siswa (komunikan) dan tujuan pembelajaran

Jadi media pembelajaran adalah segala sesuatu yang dapat
digunakan untuk menyalurkan pesan (bahan pembelajaran), sehingga
dapat merangsang perhatian, minat, pikiran, dan perasaaan siswa dalam

kegiatan belajar untuk mencapai tujuan belajar (Daryanto, 2010: 5).
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3. Fungsi Media Pembelajaran

Dalam proses pembelajaran, media memiliki fungsi sebagai

pembawa informasi dari sumber (guru) menuju penerima (siswa). Media

pembelajaran hendaknya diupayakan untuk memanfaatkan kelebihan-

kelebihan yang dimiliki oleh media tersebut dan berusaha menghindari

hambatan-hambatan yang mungkin muncul dalam proses pembelajaran.

Secara rinci, fungsi media dalam proses pembelajaran adalah sebagai

berikut.

a.

Menyaksikan benda yang ada atau peristiwa yang terjadi pada masa
lampau. Dengan perantara gambar, potret, slide, film, video, atau
media lain, siswa dapat memperoleh gambaran yang nyata tentang
benda atau peristiwa.

Mengamati benda atau peristiwa yang sukar dikunjungi, baik karena
jaraknya jauh, berbahaya, atau terlarang. Misalnya video harimau di
hutan.

Memperoleh gambaran yang jelas tentang benda atau hal-hal yang
sukar diamati secara langsung karena ukurannya yang tidak
memungkinkan, baik karena terlalu besar atau terlalu kecil.

Dengan mudah membandingkan sesuatu. Dengan bantuan gambar,
model atau foto siswa dapat dengan mudah membandingkan dua
benda berbeda sifat ukuran, warna, dan sebagainya.

Dapat melihat secara cepat suatu proses yang berlangsung secara

lambat. Dengan video, proses perkembangan katak dari telur sampai
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menjadi katak dapat diamati hanya dalam waktu beberapa menit

(Daryanto, 2010: 10).

4. Kriteria Pemilihan Media
Pembelajaran yang efektif memerlukan perencanaan yang baik.
Media yang akan digunakan dalam proses pembelajaran itu juga
memrlukan perencanaan yang baik. Meskipun demikian, kenyataan di
lapangan menunjukkan bahwa seorang guru memilih salah satu media
dalam kegiatannya dikelas atas dasar pertimbangan misalnya ia merasa
sudah akrab dengan media itu, merasa bahwa media yang dipilihnya dapat
menggambarkan dengan lebih baik dari pada dirinya sendiri, kemudian
media yang dipilihnya dapat menarik minat, dan perhatian siswa, serta
menuntunnya pada panyajian yang lebih terstruktur dan terorganisasi.
Dalam pemilihan media sebaiknya mempertimbangkan juga
a. Kemampuan mengakomodasi penyajian stimulus yang tepat (visual
dan audio).
b. Kemampuan mengakomodasi respon siswa yang tepat (tertulis, audio,
atau kegiatan fisik).
c. Kemampuan mengakomodasi umpan balik.
d. Pemilihan media utama dan media skunder untuk penyajian informasi
atau stimulus, dan untuk latihan dan tes (sebaiknya latihan dan tes

menggunakan media yang sama).
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Kriteria yang paling utama dalam pemilihan media bahwa media
harus disesuaikan dengan tujuan pembelajaran yang ingin dicapai. Ada
juga beberapa kriteria lain yang patut diperhatikan (Azhar Arsyad, 1997:
73).

a. Media dipilih berdasarkan tujuan instruksional yang telah diterapkan
yang secara umum mengacu kepada salah satu atau gabungan dari dua
atau tiga ranah kognitif, efektif, dan psikomotorik. Tujuan ini dapat
digambarkan dalam bentuk tugas yang harus dikerjakan atau
dipertunjukkan oleh siswa, seperti menghafal, melakukan kegiatan
yang melibatkan kegiatan fisik atau pemakaian prinsip-prinsip seperti
sebab-akibat.

b. Tepat untuk mendukung isi pelajaran yang sifatnya fakta, konsep,
prinsip atau generalisasi. Media yang berbeda, misalnya film dan
grafik memerlukan symbol dan kode yang berbeda, dan oleh karena
itu memerlukan proses dan keterampilan mental yang berbeda untuk
memehaminya.

c. Media harus selaras dan sesuai dengan kebutuhan tugas pembelajaran
dan kemampuan mental siswa.

d. Praktis, luwes, dan bertahan. Jika tidak tersedia waktu, dana, atau
sumber daya lainnya untuk memproduksi, tidak perlu dipaksakan,
media yang yang mahal memakan waktu yang lama untuk

memproduksinya, bukanlah jaminan sebagai media yang terbaik.
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e. Mutu teknis. Pengembangan visual baik gambar maupun fotografi
harus memenuhi persyaratan teknis tertentu. Misalnya, visual slide
harus jelas dan informasinya atau pesan yang ditonjolkan dan ingin
disampaikan tidak boleh terganggu oleh elemen lain berupa latar

belakang.

B. Microsoft Excel

Microsoft Excel adalah aplikasi spreadsheet canggih yang dijalankan
dibawah sistem operasi Windows. Program ini menjadi andalan untuk
menghitung, menganalisis, dan mempresentasikan data. Microsoft Excel
dibandingkan dengan aplikasi sejenis lainnya untuk mengolah spreadsheet
dikarenakan banyak sekali kemudahan dan kelebihan yang disediakan
sehingga hasil pengolahan data dapat langsung didapat secara cepat dengan
hasil yang optimal.

Microsoft Excel menawarkan banyak keunggulan antarmuka jika
dibandingkan dengan program spreadsheet yang mendahuluinya, tapi
esensinya masih sama dengan VisiCalc (perangkat lunak spreadsheet yang
terkenal pertama kali) Sel disusun dalam baris dan kolom, serta mengandung
data atau formula dengan berisi referensi absolut atau referensi relatif
terhadap sel lainnya.

Microsoft Excel merupakan program spreadsheet pertama yang
mengizinkan pengguna untuk mendefinisikan bagaimana tampilan dari

spreadsheet yang mereka sunting font, atribut karakter, dan tampilan setiap
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sel. Excel juga menawarkan penghitungan kembali terhadap sel-sel secara
cerdas, di mana hanya sel yang berkaitan dengan sel tersebut saja yang akan
diperbarui nilainya (dimana program-program spreadsheet lainnya akan
menghitung ulang keseluruhan data atau menunggu perintah khusus dari
pengguna). Selain itu, Excel juga menawarkan fitur pengolahan grafik yang

sangat baik.

C. Multimedia
1. Pengertian Multimedia

Multimedia terbagi menjadi dua kategori, yaitu multimedia linier
dan multimedia interaktif. Multimedia linier adalah suatu multimedia yang
tidak dilengkapi dengan alat pengontrol apapun yang dapat dioperasikan
oleh pengguna. Multimedia ini berjalan sekuensial (berurutan), misalnya
TV dan film. Multimedia interaktif adalah suatu multimedia yang
dilengkapi dengan alat pengontrol yang dioperasikan oleh pengguna,
sehingga pengguna dapat memilih apa yang dikehendaki untuk proses
selanjutnya. Misalnya multimedia interaktif, aplikasi game dan lain-lain
(Daryanto, 2010: 51).

Definisi  multimedia sebagai  presentasi materi dengan
menggunakan kata-kata sekaligus gambar-gambar, yang dimaksud kata
disini adalah materi yang disajikan dalam bentuk verbal, misalnya
menggunakan teks kata-kata yang tercetak atau terucap. Sedangkan yang

dimaksud dengan gambar adalah materinya disajikan dalam bentuk
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gambar. Hal ini bisa dalam bentuk grafik statis misalnya ilustrasi, grafik,
foto dan peta atau menggunakan grafik dinamis misalnya animasi dan
video. (Richard E.Mayer, 2001: 3)

Media pembelajaran berbasis multimedia haruslah mudah
digunakan yang memuat navigasi-navigasi sederhana yang memudahkan
pengguna. Selain itu harus menarik agar merangsang pengguna tertarik
menjelajah seluruh program, sehingga seluruh materi pembelajaran yang
terkandung didalamnya dapat terserap dengan baik. Materi pembelajaran
yang terkandung didalamnya juga harus disesuaikan dengan kebutuhan
pengguna, sesuai dengan kurikulum dan mengandung banyak manfaat.
Media pembelajaran berbasis multimedia tersebut juga harus mudah
instalasi pada komputer, serta tidak perlu memerlukan CD dalam
menjalankannya. Karena dengan kemudahan tersebut membuat pengguna

merasa lebih praktis dan penyebarannya akan lebih luas.

2. Karakteristik Media Dalam Multimedia Pembelajaran

Sebagai salah satu komponen sistem pembelajaran, pemilihan dan
penggunaan multimedia pembelajaran harus memperhatikan karakteristik
komponen lain seperti tujuan, materi, strategi, dan juga evaluasi
pembelajaran.
Karakteristik multimedia pembelajaran adalah sebagai berikut
a. Memiliki lebih dari satu media yang konvergen, misalnya

menggabungkan unsur audio dan visual.
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b. Bersifat interaktif, dalam pengertian memiliki kemampuan untuk
mengakomodasi respon pengguna.

c. Bersifat mandiri, dalam pengertian memberikan kemudahan dan
kelengkapan isi sedemikian rupa sehingga pengguna bisa menggunakan
tanpa bimbingan orang lain.

Selain  memenuhi ketiga karakteristik tersebut, multimedia
pembelajaran sebaiknya juga memenuhi fungsi sebagai berikut :
a. Mampu memperkuat respon pengguna secepatnya dan sesering
mungkin.
b. Mampu memberikan kesempatan kepada siswa untuk mengontrol laju
kecepatan belajarnya.
c. Memperhatikan bahwa siswa mengikuti suatu urutan yang jelas dan
terkendalikan.
Mampu memberikan kesempatan adanya partisipasi dari
penggunaan dalam bentuk respon, baik berupa pemilihan, keputusan serta

percobaan (Daryanto, 2010: 53-54).

D. Media Pembelajaran yang Baik
Dalam membuat media pembelajaran menggunakan bantuan komputer
biasakan untuk membuat naskah secara manual terlebih dahulu. Naskah
tersebut merupakan draf atau rancangan yang selanjutnya akan digunakan
dalam pembuatan media pembelajaran, dengan telah memiliki naskah tersebut,

maka ketika memproduksinya dengan komputer kita sudah tidak lagi
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memikirkan sistematika sajian materi serta terhindar dari kesalahan materi.

Yang perlu diperhatikan dalam membuat media pembelajaran adalah.

a.

Menggunakan jenis huruf (font) yang tingkat keterbacaanya tinggi,
misalnya arial, verdana, atau Tahoma. Gunakan ukuran huruf (font size)
untuk isi teks, sedangkan untuk sub judul 28 dan untuk judul 30.
Menggunakan variasi warna, gambar, foto, animasi atau video untuk
memperjelas dan memperindah tampilan.

Area tampilan frame yang ditulis jangan melebihi ukuran 16x20 cm.
Dalam satu frame usahakan hanya berisi satu topik atau sub topik
pembahasan.

Memberi judul pada setiap frame.

Memperhatikan ~ komposisi  warna, keseimbangan (tata letak),
keharmonisan, dan kekontrasan pada setiap tampilan.

Memberikan variasi memang perlu, tetapi harus juga diperhatikan prinsip

keserderhanaan.

. Artinya jangan membuat tampilan slide yang terlalu rumit, rame dan

penuh dengan warna warni, karena hal ini justru akan menganggu pesan

utama yang disajikan (Daryanto, 2010: 72).

Media pembelajaran yang baik harus memenuhi beberapa syarat yaitu

a.

b.

Harus mampu meningkatkan motivasi pembelajar,
Memberikan rangsangan untuk belajar lebih lanjut,
Mengaktifkan pembelajar dalam memberikan tanggapan umpan balik, dan

Mendorong pembelajar melaksanakan praktek dengan benar.
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Semakin banyak tujuan pembelajaran yang bisa dibantu dengan sebuah

media semakin baik media tersebut.

Menurut Thorn (1995: 65) ada enam kriteria untuk menilai multimedia

interaktif yaitu :

a.

Kemudahan navigasi, program dirancang sesederhana mungkin sehingga
pembelajar tidak perlu belajar komputer lebih dahulu,

Kandungan kogpnisi,

Pengetahuan dan presentasi informasi keduanya untuk menilai isi program
apakah sudah memenuhi kebutuhan pembelajaran,

Integrasi media di mana media harus mengintegrasikan aspek dan
ketrampilan yang harus dipelajari,

Untuk menarik minat pembelajar program harus mempunyai tampilan
yang artistik dan estetika yang baik,

Fungsi secara keseluruhan program yang dikembangkan harus
memberikan pembelajaran yang diinginkan oleh pembelajar. Sehingga
pada waktu seorang selesai menjalankan sebuah program dia akan merasa
telah belajar sesuatu.

Berdasarkan pada uraian di atas maka penilaian media belajar yang

baik pada pembuatan media ini didasarkan pada dua hasil penilaian yaitu :

a.

Penilaian dari sudut pandang kemanfaatan atau segi praktis, dilihat dari :
1) Kemampuan meningkatkan motivasi pembelajar atau semangat belajar.

2) Kemampuan dalam memberikan rangsangan untuk belajar lebih lanjut.



3)

4)

21

Kemampuan mengaktifkan pembelajar dalam memberikan tanggapan
umpan balik.
Kemampuan mendorong pembelajar untuk melaksanakan praktek

dengan benar.

. Penilaian dari sudut pemrograman atau segi teknis yaitu :

1)

2)

3)

4)

5)

6)

7)

8)

Mudah disimpan dan dipublikasikan.

Mudah diakses.

Kemudahan navigasi, program dirancang sesederhana mungkin.
Kandungan kognisi disesuaikan dengan tujuan belajar sehingga dapat
dijadikan sebagai sumber belajar.

Pengetahuan dan presentasi informasi keduanya untuk menilai isi
program apakah sudah memenuhi kebutuhan pembelajaran,

Integrasi media di mana media harus mengintegrasikan aspek dan
ketrampilan yang harus dipelajari,

Untuk menarik minat pembelajar program harus mempunyai tampilan
yang artistik dan estetika yang baik,

Fungsi secara keseluruhan program yang dikembangkan harus
memberikan pembelajaran yang diinginkan oleh pembelajar. Sehingga
pada waktu seorang selesai menjalankan sebuah program media akan

merasa telah belajar sesuatu.
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E. Program Adobe Flash

Program Adobe Flash merupakan salah satu software bagian dari
keluarga Adobe, yang sekarang menjadi salah satu standar untuk industri
animasi dan web yang banyak digunakan. Keunikan dan kelebihan adobe
flash ini adalah mampu membuat animasi vector dan interaktivitas yang
menarik. Adapun dalam tampilannya dengan interface yang baru,
memudahkan didalam membuat sebuah animasi dan presentasi. Presentasi
sendiri merupakan istilah yang digunakan untuk memberikan suatu
penjelasan baik secara visual ataupun non visual yang disampaikan kepada
audience atau pendengar dalam rangka menjelaskan suatu permasalahan
serta penyelesaian masalah maupun dalam rangka mempublikasikan
suaatu karya cipta atau produk. Program Adobe Flash dikembangkan di
perusahaan adobe.

Aplikasi ini  sangat banyak digunakan oleh perusahaan
pengembang multimedia, para pendidik, siswa dan trainer. Program
aplikasi ini sebernarnya merupakan program untuk membuat animasi
namun dapat dipergunakan untuk membuat program pembelajaran.
Program yang dihasilkanpun akan cukup menarik karena memiliki
beberapa fasilitas seperti :

1. Memasukkan Teks, Gambar, Suara dan Video
Fasilitas yang penting dari program aplikasi ini adalah
fasilitas untuk menampilkan teks. Dengan fasilitas ini pembuat

program bisa menampilkan berbagai teks untuk berbagai keperluan
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misalnya untuk pembelajaran menulis, membaca atau pembelajaran
yang lain. Selain itu juga dilengkapi dengan fasilitas tampilan
gambar, suara, dan video untuk memperjelas materi yang
disampaikan.
Membuat tampilan menarik

Tampilan yang manarik akan meningkatkan minat dan
motivasi pembelajar untuk menjalankan program. Ada beberapa
fasilitas yang disediakan untuk membuat tampilan menarik.
Fasilitas yang pertama adalah background. Background akan
memperindah tampilan program. Fasilitas ini yang akan membuat
tampilan lebih menarik adalah fasilitas animasi. Dengan fasilitas
ini gambar-gambar dan teks akan muncul ke layar dengan cara
tampilan yang lebih menarik.
Membuat Hyperlink

Fasilitas ini sangat penting dan sangat mendukung
pembelajaran bahasa karena dengan hyperlink program bisa
terhubung ke program lain atau ke jaringan internet. Hyperlink atau
hubungan dalam satu program akan memungkinkan programer
memberikan umpan balik secara langsung terhadap proses
pembelajaran. Hubungan dengan program lain akan memperkaya
fasilitas yang mendukung pembelajaran dan hubungan dengan
internet akan membuka berbagai kemungkinan pembelajaran yang

lebih luas, pribadi dan otentik.
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F. XML (Extensible Markup Language)

XML terletak pada inti web service, yang digunakan untuk
mendeskripsikan data. Fungsi utama dari XML adalah komunikasi antar
aplikasi, integrasi data, dan komunikasi aplikasi eksternal dengan partner
luaran. Dengan standarisasi XML, aplikasi-aplikasi yang berbeda dapat
dengan mudah berkomunikasi antar satu dengan yang lain.

XML (Extensible Markup Language) saat ini sangat popular.
Format penyimpanan data dalam XML membuat platform ini independen
dan bermacam aplikasi dapat memprosesnya dengan mudah, tidak
terkecuali Adobe Flash yang juga dapat bekerja dengan file XML.

Dalam kaitanya dengan bahasa pemrograman, kata extensible
berarti pengembang dapat mengembangkan kemampuannya lebih lanjut.
Informasi dalam XML disimpan didalam tag. Markup berarti sebuah
bahasa yang dibangun dengan menggunakan tag untuk mengelilinginya
atau markup text.

Kemajuan teknologi multimedia Adobe Flash dan database
khususnya XML membawa mengaruh terhadap perkembangan teknik-
teknik dalam membangun aplikasi multimedia. Awalnya, aplikasi
multimedia bersifat statis yang artinya isi informasi yang disajikan tidak
dapat berubah.

Intergrasi antara aplikasi Adobe Flash dan database XML mampu
membuat aplikasi multimedia menjadi bersifat dinamis, yang berarti

informasi yang disampaikan dapat di update tanpa harus mengganti file
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mentahnya. Integrasi ini dapat membuat aplikasi multimedia yang lebih

kaya (Rich Multimedia Application) (Andi Sunyoto, 2010).

. Standar Kompetensi pada mata pelajaran TIK di SMA

Tugas utama pendidikan adalah mengembangkan segenap potensi
siswa sebagai sumber daya manusia sehingga ia dapat didayagunakan
sebagai modal pembangunan dan mempesiapkan peserta didik untuk dapat
menghadapi masalah yang terjadi. Hal ini sesuai prinsip pelaksanaan pada
KTSP, bahwa penyelengaraan pendidikan perlu diadaptasikan sesuai
dengan kondisi sekolah, masyarakat, serta pengembangan ilmu
pengetahuan dan teknologi, terutama teknologi informasi yang
berkembang pesat bersama era globalisasi, untuk itu pemerintah
memberlakukan mata pelajaran TIK.

Mata pelajaran TIK perlu diperkenalkan, dipraktekkan dan
dikuasai peserta didik sedini mungkin agar mereka memiliki bekal untuk
menyesuaikan diri dalam kehidupan global yang ditandai dengan
perubahan yang sangat cepat. Untuk menghadapi perubahan tersebut
diperlukan kemampuan dan kemauan untuk belajar sepanjang hayat.
Dengan demikian pendidikan perlu disesuaikan dengan tuntutan dan
kebutuhan kehidupan, untuk itu maka pada pelajaran TIK ada beberapa

hal-hal yang perlu dipelajari dan dikuasai oleh siswa diantaranya:
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Memahami fungsi dan proses kerja berbagai peralatan teknologi
informasi dan komunikasi yang ditopang oleh sikap cermat dan
menghargai hak atas kekayaan intelektual.

Menggunakan perangkat pengolah kata, pengola angka, pembuatan
grafis dan pembuat presentasi dengan variasi tabel, grafik, gambar dan
diagram untuk menghasilkan informasi.

Memahami prinsip dasar internet atau intranet dan menggunakannya
untuk memperoleh informasi, berkomunikasi dan bertukar informasi

(http://www.docstoc.com/docs/24409426/87-TIK-SMA).

Mata pelajaran teknologi informasi dan komunikasi (TIK)

bertujuan agar peserta didik memiliki kemampuan sebagai berikut:

1.

2.

Memahami teknologi informasi dan komunikasi.

Mengembangkan keterampilan untuk memanfaatkan teknologi
Informasi dan komunikasi.

Mengembangkan sikap kritis, apresiatif dan mandiri dalam
penggunaan teknologi informasi dan komunikasi.

Menghargai karya cipta dibidang teknologi informasi dan komunikasi.
Agar dalam kegiatan pembelajaran dapat berjalan dengan baik, untuk
itu guru harus mampu memahami dan menguasai standar kompetensi

(http://www.docstoc.com/docs/24409426/87-TIK-SMA).

Kurikulum Teknologi Informasi dan Komunikasi (TIK) telah

ditetapkan secara nasional. Kurikulum tersebut terdiri atas Standar

Kompetensi dan Kompetensi Dasar. Standar Kompetensi dan Kompetensi
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Dasar menjadi arah dan landasan untuk mengembangkan materi pokok,
kegiatan pembelajaran, dan indikator pencapaian kompetensi untuk
penilaian. Standar Kompetensi TIK untuk Kelas X1 semester genap adalah
menggunakan perangkat lunak pengolah angka untuk menyajikan
informasi.
Standar Kompetensi tersebut memuat tiga Kompetensi Dasar,
yaitu:
1. Menggunakan menu dan ikon yang terdapat dalam perangkat lunak
pengolah angka.
2. Membuat dokumen pengolah angka dengan variasi teks, tabel, grafik,
gambar, dan diagram.
3. Mengolah dokumen pengolah angka dengan variasi teks, tabel, grafik,
gambar, dan  diagram  untuk = menghasilkan  informasi

(http://www.docstoc.com/docs/24409426/87-TIK-SMA).

Berdasarkan hasil pengamatan, siswa merasa kesulitan pada materi
menu dan ikon pada aplikasi pengolah angka serta penggunaan formula
pada Microsoft Excel. Seperti pada materi menu dan ikon pada aplikasi
pengolah angka. Disini siswa dituntut untuk mengerti dan dapat
menjelaskan berbagai macam menu dan ikon beserta fungsinya. Selain itu
juga pada penggunaan formula pada Microsoft Excel. Materi ini cukup
sulit dipahami oleh siswa. Biasanya mengajarkan materi ini guru
menerangkan materi dan memberi contoh kemudian siswa membuat

catatan kemudian bertanya jika ada informasi yang tidak dimengerti. Hal
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ini berakibat guru merasa kewalahan dalam melaksanakan pembelajaran
karena dalam melaksanakan pembelajaran siswa banyak memberikan
pertanyaan. Kadangkala guru tidak memperhatikan siswa yang mengalami

kelemahan dalam memahami materi TIK.

H. Hasil Penelitian Yang Relevan

Mohamad Amin pada tahun 2009 dalam judul penelitian
pengembangan media pembelajaran teknik kerja membubut ulir berbasis
multimedia menjelaskan bahwa dari uji kelayakan penelitian ini diperoleh
hasil yang baik oleh ahli media sebesar 77.31%, ahli materi sebesar
76.79% dan mahasiswa sebesar 79.05%. Dari hasil tersebut dapat
disimpulkan bahwa uji kelayakan yang dihasilkan adalah baik.

Vabio Christofel Nanulaitta pada tahun 2010 dalam judul
pengembangan media pembelajaran berbasis multimedia pada mata
pelajaran bahasa inggris kelas XI IPA | SMA Negeri 2 Ambon
menjelaskan bahwa kelayakan media pembelajaran berbasis multimedia
pada mata pelajaran bahasa Inggris mencapai kualifikasi sangat tinggi
dimana rerata produk pengembangan adalah 90, 87 %. Hasil validasi Ahli
media pembelajaran adalah produk pengembangan mencapai kualifikasi
sangat tinggi dengan rerata nilai 93, 91 %. Hasil validasi Ahli disain
pembelajaran adalah produk pengembangan mencapai kualifikasi cukup
tinggi dengan rerata nilai 70 %. Hasil uji coba perorangan produk

pengembangan mencapai rerata 88 % dinyatakan tinggi tingkat
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kualifikasinya. Dengan demikian media pembelajaran berbasis multimedia
pada mata pelajaran bahasa Inggris kelas XI IPA I SMA Negeri 2 Ambon
berada pada tingkat persentasi tinggi untuk peningkatan strategi
penyampaian pesan pembelajaran.

I. Kerangka Berfikir

Media pembelajaran adalah bahan, alat, atau teknik yang
digunakan dalam kegiatan belajar mengajar dengan maksud agar proses
interaksi  komunikasi pembelajaran antara guru dan siswa dapat
berlangsung secara tepat guna dan berdaya guna.

Microsoft Excel adalah Program aplikasi pada Microsoft Office
yang digunakan dalam pengolahan angka (Aritmatika). Kesulitan yang
dialami oleh siswa SMA Negeri 1 Ngemplak untuk menggunakan
Microsoft Excel adalah siswa tidak bisa menggunakan rumus pada
Microsoft Excel, sehingga pemahaman ralatif lama.

Peran media pembelajaran menjadi sangat penting didalam strategi
pembelajaran sebagai alat bantu mengajar yang turut mempengruhi situasi,
kondisi, dan lingkungan belajar yang direncanakan, dipersiapkan dan
diciptakan oleh guru.

Dengan adanya media pembelajaran Microsoft Excel Berbasis
multimedia dapat mempermudah peserta didik untuk mempelajari
Microsoft Excel, Menyediakan tutorial yang tidak mudah didapat melalui
materi-materi yang lain dan menjadikan proses belajar mendalam dan

beragam.
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METODE PENELITIAN

A. Desain Peneletian

Metode yang digunakan dalam penelitian ini menggunakan
pendekatan penelitian pengembangan (Research and Development).
Metode penelitian dan pengembangan adalah metode penelitian yang
digunakan untuk menghasilkan produk tertentu dan untuk dapat
menghasilkan produk tersebut digunakan penelitian yang bersifat analisis
kebutuhan (Sugiyono, 2006: 407).

Berikut ini gambar diagram metode penelitian yang dibuat untuk

mempermudah dalam media pembelajaran Microsoft Excel berbasis

multimedia:
Kompetensi Potensi Analisis Desain
Masalah Kebutuhan Implementasi
Ujicoba Revisi Valid:.;lsi Produk
Pemakaian Produk Ahli
Revisi Produk
Produk Masal

Gambar 1. Langkah-langkah penggunaan Metode Research and Development

(Adaptasi dari Sugiyono, 2008: 298)
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Langkah-langkah penelitian R&D tersebut dapat dijelaskan dalam

beberapa uraian berikut :

1. Kompetensi
Kurikulum Teknologi Informasi dan Komunikasi (TIK) telah
ditetapkan secara nasional. Kurikulum tersebut terdiri atas standar
kompetensi dan kompetensi dasar. standar kompetensi dan kompetensi
dasar menjadi arah dan landasan untuk mengembangkan materi pokok,
kegiatan pembelajaran, dan indikator pencapaian kompetensi untuk
penilaian. Standar kompetensi TIK untuk kelas XI semester genap adalah
menggunakan perangkat lunak pengolah angka untuk menyajikan
informasi.
Standar kompetensi tersebut memuat tiga kompetensi dasar, yaitu:
a. Menggunakan menu dan ikon yang terdapat dalam perangkat lunak
pengolah angka.
b. Membuat dokumen pengolah angka dengan variasi teks, tabel, grafik,
gambar, dan diagram.
c. Mengolah dokumen pengolah angka dengan variasi teks, tabel, grafik,

gambar, dan diagram untuk menghasilkan informasi.

Berikut ini adalah beberapa kelebihan multimedia yang dapat
digunakan sebagai standar kompetensi multimedia dalam media

pembelajaran ini adalah sebagai berikut :
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a. Interaktivitas multimedia atau media lain yang berbasiskan komputer
adalah yang paling nyata.

b. Pengguna dapat mengontrol sendiri proses pembelajaran, baik dari
segi menyesuaikan kemampuan, kesiapan dan keinginan pengguna.

c. Multimedia menyampaikan isi pelajaran dengan canggih dan
berkesan.

d. Multimedia mampu menjadi sumber pengetahuan.

e. Multimedia kaya dengan berbagai aktivitas pembelajaran.

f. Dengan multimedia, proses pembelajaran tidak lagi terbatas oleh

ruang dan waktu.

Potensi dan Masalah

Potensi adalah segala sesuatu yang didayagunakan akan memiliki
nilai tambah. Dalam penelitian ini, potensi yang ditemukan adalah
kemajuan teknologi yang semakin pesat sehingga mendukung untuk
mengembangkan media pembelajaran berbasis multimedia, serta semakin
bertambahnya orang yang berminat untuk mempelajari Microsoft Excel.

Masalah adalah penyimpangan antara yang diharapkan dengan
yang terjadi. Dalam penelitian ini masalah yang ditemukan adalah siswa
merasa kesulitan memahami Microsoft Excel, alat bantu pembelajaran

yang tersedia kurang menarik perhatian.
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3. Analisis Kebutuhan
Perkembangan teknologi yang semakin pesat sangat mendukung
untuk dikembangkannya suatu media pembelajaran yang lebih menarik
dengan berbasis multimedia. Dengan melihat kenyataan bahwa siswa
merasa kesulitan dalam mempelajari Microsoft Excel, maka media ini
diharapkan dapat membantu proses pembelajaran Microsoft Excel pada
pelajaran TIK.
Pengalaman yang dialami penulis dalam mempelajari Microsoft
Excel memberikan ide bagi penulis untuk mengembangkan media
pembelajaran dengan memanfaatkan keterampilan dalam mengembangkan
media dan pengetahuan yang dimiliki tentang media serta Microsoft Excel.
Untuk membuat media pembelajaran Microsoft Excel dibutuhkan standar
kompetensi sebagai acuan materi dalam pembuatan media pembelajaran
Microsoft Excel dan standar media yang baik.
Perangkat pendukung yang digunakan dalam penelitian ini adalah:
a. Perangkat Keras
Media pembelajaran Microsoft Excel berbasis multimedia ini dibuat
dengan menggunakan sebuah note book Compag dengan proses AMD
Athlon™ X2 Dual Core QL-64 2.10 GHz, RAM 1 GB, windows xp

service pack Il dan mouse optic standar Windows.

b. Perangkat Lunak
Proses pembuatan media pembelajaran berbantuan komputer

menggunakan gabungan dari beberapa perangkat lunak. Perangkat lunak
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yang digunakan adalah sebagai berikut: Adobe Flash Cs 3, XML, Adobe
Captivate, CorelDraw X 3, adobe photoshop CS 3, Photoscape, Nero

Audio 6.0 serta program perangkat lunak pendukung lainnya.

4. Desain Implementasi
Implementasi merupakan tahap menterjemahkan bagian-bagian
yang merupakan hasil desain ke dalam bentuk aplikasi dengan
menggunakan bahasa pemrograman tertentu dan menyatukannya menjadi
kesatuan sistem yang lebih komplit. Implementasi bertujuan untuk
mengemukakan tujuan pokok dari tahap analisis untuk kemudian
dituangkan dalam bentuk rancangan atau model. Langkah-langkah yang
harus dilakukan dalam implementasi tersebut adalah :
a. Mengumpulkan dan memilih bagian-bagian yang akan diterjemahkan
ke bahasa pemrograman.
b. Menentukan program yang dibutuhkan sebagai pendukung program
yang telah dirancang.
c. Menerjemahkan prosedur, sub-rutin dan fungsi-fungsi dari bagian-
bagian ke dalam bahasa pemrograman.
d. Menyatukan prosedur, sub-rutin dan fungsi-fungsi dari bagian-bagian
yang telah dibuat ke dalam kesatuan program.
Ada beberapa tahap dalam merancang desain produk, yaitu :
a. Desain materi
Desain materi ditentukan berdasarkan hasil analisis kebutuhan. Di

dalam desain materi terdapat materi apa saja yang akan disajikan di dalam
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media pembelajaran. Desain ini merupakan gambaran kerja sistem yang
masih bersifat umum. Berdasarkan analisis tujuan dan analisis materi,

desain materi program dapat digambarkan melaui gambar peta materi di

Microsoft
Excel

bawah ini.

> Pendahuluan

> Pengenalan

— P> Materi 1 —1 > Menu

> Ikon

—» Membuat Dokumen

Pengolahan Data

— Materi 2 Pengeditan

Pemformatan

Pendahuluan
— Materi 3

Fungsi

Gambar

—p Materi 4

Grafik

Gambar 2. Desain Materi Program
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b. Desain Diagram Alur (Flowchart)

Tahapan selanjutnya adalah mentransformasikan diagram materi
ke dalam diagram alur. Diagram alur menggambarkan urutan pengerjaan
program dengan memanfaatkan simbol-simbol tertentu. Diagram alur
program digunakan untuk menggambarkan tiap-tiap langkah dalam

program komputer secara logika.



Petunjuk penggunaan

Menu Utama

Ya

Pilih
Pendahuluan

Evaluasi
Tidak

Kembali

Pi

Gambar 3. Diagram Alur Program

Ya

> Materi
Ya
Pilih

Menu
Utama

Menu
Utama

Menu
Utama

Menu
Utama

Pili

Tidak

|

Pendahuluan

Ya
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Menu
Utama

Menu
Utama

Menu
Utama



Start

v
Judul

v
Petunjuk
penggunaan

\ 4
Menu Utama

v

Pendahuluan

v

Kompetensi

Gambar 4. Diagram Alur Kompetensi
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Judul

v

Petunjuk
penggunaan

h 4
Menu Utama

v

Materi

Gambar 5. Diagram Alur Materi

Materi Materi Materi Materi
Materi 1 Materi 1 Materi 1 Materi 1

v

Pendahuluan

Membuat
Judul

Ya

Gambar 6. Diagram Alur Materi 1
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Materi Materi Materi
Materi 2 Materi 2 Materi 2
Pengolahan Pengeditan Pemformatan

Data

Selesai

Gambar 7. Diagram Alur Materi 2

4

Materi Materi
Materi 2 Materi 2
v

Penduhuluan

Selesai

Gambar 8. Diagram Alur Materi 3
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Materi Materi
Materi 2 Materi 2

Tidak

Gambar 9. Diagram Alur Materi 4

Start

\ 4
Judul

v

Petunjuk
penggunaan

\ 4
Menu Utama

v

Pendahuluan

v
Latihan

Selesai

Gambar 10. Diagram Alur Latihan
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Start

\ 4
Judul

v

Petunjuk
penggunaan

\ 4
Menu Utama

v

Pendahuluan

\ 4
Evaluasi

Selesai

Gambar 11. Diagram Alur Evaluasi



Judul

v
Petunjuk
penggunaan

A
Menu Utama

v

Pendahuluan

A

Profil

Ya
Selesai

Gambar 12. Diagram Alur Profil
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Start

A

Judul

v

Petunjuk
penggunaan

\ 4
Menu Utama

v

Pendahuluan

Gambar 13. Diagram Alur Exit

c. Desain Tampilan Layar

Desain  tampilan layar digunakan untuk mempermudah
programmer mentransformasikan ke dalam bahasa pemrograman. Setiap
proses digambarkan dalam desain tampilan layar. Desain tampilan layar
secara detail disajikan dalam bentuk storyboard. Storyboard merupakan
pemikiran yang divisualisasikan dan dideskripsikan melaui tulisan,
direncanakan dalam musik dan efek suara. Hasil dari pembuatan
storyboard akan digunakan dalam proses pembuatan program multimedia,

sehingga proses produksi akan lebih terstruktur dan teratur.
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5. Validasi Ahli

Pada tahap ini dilakukan secara terbatas terhadap kelompok kecil
sebagai sampel pengguna produk untuk mengetahui kelemahan produk
serta menghadirkan ahli materi dan ahli media. Ujicoba produk dapat
dilakukan dengan forum diskusi dengan ahli materi dan ahli media. Pada
tahap ini, penulis harus selalu mengevaluasi kinerja produk untuk
mengetahui kelemahan dan kesalahannya.

Dalam penelitian ini validasi dimintakan dari berbagai pihak sesuai
dengan keahlian masing-masing antara lain :
a. Ahli Media adalah dosen yang berkompeten dalam bidang media.
b. Ahli Materi adalah guru TIK kelas XI di SMA Negeri 1 Ngemplak.

Dari kegiatan validasi tersebut akan dihasilkan draft modul yang
mendapatkan masukan dan persetujuan dari validator, sesuai dengan
bidangnya. Masukan tersebut digunakan sebagai bahan penyempurnaan

media. Validasi dilaksanakan pada bulan Mei 2011.

6. Produk
Dalam hal ini produk yang dimaksud adalah produk perangkat
lunak. Produk merupakan hasil dari suatu proses produksi yang digunakan
oleh beberapa pengguna bukan untuk pengguna pribadi. Produk dalam
penelitian ini adalah berupa “Media Pembelajaran Microsoft Excel
berbasis Multimedia” yang digunakan untuk membantu proses belajar

dalam memahami Microsoft Excel. Produk dibuat menggunakan software
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Adobe Flash 3.0 dengan bantuan software pendukung yaitu Adobe

Photoshop CS3.

Revisi Produk

Revisi atau perbaikan merupakan proses penyempurnaan media
setelah memperoleh masukan dari ahli media dan ahli materi. Kegiatan
revisi draft media bertujuan untuk melakukan finalisasi atau

penyempurnaan akhir terhadap media.

Ujicoba Pemakaian

Ujicoba ini dilakukan dengan skala besar. Pengujian ini melibatkan
pengguna sebagai calon pemakai produk. Hasil uji yang diperoleh adalah
model yang siap diterapkan di lingkungan luas. Ujicoba dilaksanakan di

SMA Negeri 1 Ngemplak pada bulan Mei 2011.

Revisi Produk
ini bertujuan untuk menyempurnakan produk yang sedang
dikembangkan. Revisi ini adalah tahap penyempurnaan setelah ada

masukan dari siswa SMA Negeri | Ngemplak.
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10. Produksi Masal
Produk yang telah disempurnakan dapat dibuat produk masal
apabila produk tersebut telah diuji coba dinyatakan efektif dan layak untuk

diproduksi masal.

B. Tempat dan Waktu Penelitian
1. Tempat Penelitian
Penelitian Media Pembelajaran Microsoft Excel berbasis multimedia
untuk kelas XI semester genap ini dilakukan di Laboratorium
Pemrograman Elektronika Fakultas Teknik Universitas Negeri
Yogyakarta dan di SMA Negeri 1 Ngemplak.
2. Waktu Penelitian
Penelitian ini dilaksanakan pada tahun ajaran 2010/2011 semester

genap yaitu pada bulan Februari-Mei 2011.

C. Subyek dan Obyek Penelitian
1. Subyek Penelitian
Subyek penelitian ini adalah siswa kelas XI SMA Negeri 1 Ngemplak.
2. Objek Penelitian
Objek penelitian ini adalah media pembelajaran Microsoft Excel

berbasis multimedia.
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D. Populasi dan Sampel

1.

Populasi

Menurut Sugiyono (2010: 117) populasi adalah wilayah
generalisasi yang terdiri atas objek atau subjek yang mempunya kualitas
dan karakteristik tertentu yang ditetapkan oleh peniliti untuk dipelajari dan
kemudian ditarik kesimpulannya. Jadi populasi bukan hanya orang, tetapi
juga objek dan benda-benda alam yang lain. Populasi juga bukan sekedar
jumlah yang ada pada objek atau subjek yang dipelajari, tetapi meliputi
seluruh karakteristik atau sifat yang dimiliki oleh subjek atau objek itu.
Populasi dalam penelitian ini adalah siswa kelas XI SMA Negeri 1
Ngemplak. Berikut ini total populasi dapat dilihat dalam tabel sebagai

berikut :

Tabel 1. Populasi Siswa Kelas XI SMA Negeri 1 Ngemplak

No Kelas Jumlah
1 XIIPA 1 22
2 XIIPA 2 22
3 XIIPS 1 26
4 XIIPS 2 27
Jumlah 98

Sample

Menurut Sugiyono (2010: 118) Bagian dari jumlah dan
karakteristik yang dimiliki oleh populasi tersebut. Teknik yang digunakan
untuk menentukan sampel yaitu proportional random sampling, dengan
alasan semua polulasi memiliki kesempatan yang sama untuk dipilih

menjadi sampel yang disesuaikan dengan jumlah siswa tiap-tiap kelas.
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Untuk menentukan besarnya sampel dalam penelitian ini, peneliti
mengacu pada tabel penentuan jumlah sampel yang dikembangkan oleh
Isaac dan Micheal dengan taraf signifikansi 5% (Sugiyono, 2007: 69-71),

maka besarnya sampel adalah 78 siswa.

Akl = 22 a=18

22
Ak2 = —=xTB =18
9

26
ga.‘x?& a1

Ak4 = ﬁﬁ?ﬁ =3l
o8

Jumlah =78
Karena perhitungan ada yang menghasilkan pecahan (terdapat
koma), maka dibulatkan ke bawah sehingga jumlah sampelnya 78. Adapun

tabel mengenai jumlah penelitian adalah sebagai berikut:

Table 2. Sampel Penelitian dari Populasi siswa kelas XI SMA Negeri 1

Ngemplak

No Kelas Populasi | Sampel

1 XIIPA 1 22 18

2 XIIPS 2 22 18

3 XIIPS 1 26 21

4 XIIPS 2 27 21
Jumlah 97 78
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Instrumen Penelitian

Instrumen pengumpulan data yang digunakan pada penelitian ini
adalah lembar evaluasi berupa angket atau kuesioner merupakan suatu teknik
atau cara pengumpulan data secara tidak langsung (peneliti tidak langsung
bertanya jawab dengan responden). Suharsimi Arikunto (2010: 194)
menjelaskan bahwa angket adalah sejumlah pertanyaan tertulis untuk
memperoleh informasi dari responden dalam arti laporan tentang pribadinya,
atau hal-hal yang diketahui.

Instrumen yang digunakan dalam penelitian ini ditujukan untuk
menilai kelayakan media pembelajaran Microsoft Excel berbasis multimedia.
Data yang diperoleh dari angket ini adalah data kuantitatif. Bentuk angket
yang digunakan adalah skala bertingkat yaitu sebuah pertanyaan diikuti oleh
kolom-kolom yang menunjukkan tingkatan-tingkatan (Suharsimi Arikunto,
1993: 195).

Adapun langkah-langkah yang ditempuh dalam pembuatan angket
mengacu pada pendapat Suharsimi Arikunto (2007: 135), yaitu :

1. Mengadakan identifikasi terhadap variabel-variabel yang ada dalam
rumusan judul penelitian atau yang tertera dalam problematika penelitian.

2. Menjabarkan variabel menjadi sub atau bagian variabel.

3. Mencari indikator dari setiap sub variabel.

4. Menderetkan diskriptor dari setiap variabel.

5. Membuat kisi-kisi angket penelitian.

6. Melengkapi instrumen dengan pedoman atau instruksi dan kata pengantar.
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Berikut ini akan diberikan kisi-kisi instrumen untuk masing-masing
responden.
1. Instrumen untuk Ahli Meteri
Kisi-kisi instrumen untuk ahli materi dapat ditinjau dari aspek
kualitas materi dan kemanfaatan materi dapat dilihat pada tabel di bawah
ini.

Table 3. Kisi-kisi Instumen Untuk Ahli Materi

No Aspek Indikator

1 Menu Ikon - Pengenalan program Microsoft Excel

- Menu-menu dalam Microsoft Excel

- Fungsi ikon-ikon

- Membuat lembar kerja

2 Mengolah data - Mengolah data dalam lembar kerja

- Rumus dasar pada Microsoft Excel

3 Mengedit tampilan | - Menyisipkan gambar

lembarkerja dalam | - Menyisipkan grafik

Microsoft Excel

4 Kemanfaatan - Konsistensi letak tombol

- Mempunyai fungsi tombol dengan
benar

- Mempunyai fungsi fasilitas link
dengan benar

- Membatu siswa lebih fokus dalam
belajar Microsoft Excel

- Mempermudah siswa dalam praktik
Microsoft Excel

2. Instrumen untuk Ahli Media
Kisi-kisi instrumen untuk ahli media dapat ditinjau dari aspek
tampilan design, konsistensi, navigasi dan kemanfaatan, dapat dilihat pada

tabel sebagai berikut.
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Table 4. Kisi-kisi Instumen Untuk Ahli Media

No Aspek Indikator
1 Tampilan design Pemilihan font
Komposisi warna
Kualitas gambar
2 Konsistensi Tata letak tombol
Penggunaan warna yang konsisten
Pemilihan font yang konsisten
3 Navigasi Fungsi tombol
Fungsu link
4 Kemanfaatan Membatu siswa lebih fokus dalam

belajar Microsoft Excel
Mempermudah siswa dalam praktik
Microsoft Excel

3. Instrumen Untuk Pengguna (user)

Kisi-kisi instrumen untuk pengguna (user) dapat ditinjau

dari aspek kualitas materi, konsistensi, navigasi, dan kemanfaatan

dapat dilihat pada tabel di bawah ini.

Table 5. Kisi-kisi instumen untuk pengguna

No Aspek Indikator
1 Menu ikon - Fungsi menu ikon
- Membuat lembar kerja
2 Pengolahan data - Rumus dasar
3 Edit tampilan - Insert gambar
- Insert grafik
4 Tampilan design -  Font
- Warna
- Gambar
5 Konsistensi - Tombol
6 Navigasi - Tombol
- Link
7 Kemanfaatan - Fokus Belajar

- Mempermudah praktik
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F. Uji Coba Instrumen

Sebelum Instrumen digunakan dalam penelitian, maka instrumen harus
diuji cobakan terlebih dahulu. Hal tersebut dilakukan guna bertujuan untuk
memperoleh informasi mengenai sudah atau belum terpenuhinya persyaratan.
Instrumen memunuhi syarat sebagai alat pengumpulan data yang valid dan
reliabel. Pengujian dilakukan di SMA Negeri 1| Ngemplak dengan subjek yang

digunakan untuk uji coba adalah siswa kelas XI sebanyak 19 siswa.

1. Uji Validitas

Validitas adalah suatu ukuran yang menunjukkan tingkat-tingkat
kevalidan atau kesahihan suatu instrumen. Instrumen dikatakan valid,
apabila instrumen tersebut dapat digunakan untuk mengukur yang apa
yang diinginkan. Uji validitas ini menggunakan rumus korelasi product

moment yaitu sebagai berikut :

. NEXY—(ZX)(EY)
v INER-ERTIINE Y -E YT

Keterangan :
I'xy :  Koefisien korelasi antara x dan y
N : Jumlah sampel
dx :  Jumlah skor variabel x
Yy : Jumlah skor variabel y
Y x? :  Jumlah skor kuadrat variabel x
Yy* :  Jumlah skor kuadrat variabel y
>xy : Jumlah perkalian antara skor variabel x dan skor variabel y

(Suharsimi Arikunto, 2006: 170)
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Butir soal dikatakan valid jika rhiwne Sama atau lebih besar dari ripe
dengan taraf signifikansi 5%. Jika ruiwng lebih kecil dari rype maka butir
soal dikatakan tidak valid.

Uji Reliabilitas

Menurut Suharsimi Arikunto (2006: 179) “Instrumen dikatakan
reliable bila Instrumen tersebut cukup baik sehingga mampu mengungkap
data yang dapat dipercaya”. Pengujian keandalan (reliable) variabel
dilakukan dengan menggunakan rumus Alpha Cronbach karena

pertanyaan mempunyai skor 1 sampai 4, yaitu :

HFZEJi‘[l—iﬁ

(le—1) e
Keterangan:
Tii . Reliabilitas instrumen
K :  Banyaknya butir pertanyaan
To2 :  Jumlah varian butir
gt : Varians total

(Suharsimi Arikunto, 2006:196)

Pengujian keandalan (reliable) variabel, yaitu :

¥z
11 vr
Keterangan :
L : Reliabilitas instrumen
V: . Varians responden
Vs :  Varians sisa

(Suharsimi Arikunto, 2006: 191)
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Selanjutnya hasil perhitungan r;; yang diperoleh diinterprestasikan
dengan tingkat keterandalan koefisien kolerasi sebagai berikut :

Antara 0,800 sampai dengan 1,000 : sangat tinggi

Antara 0,600 sampai dengan 0,800 : tinggi

Antara 0,400 sampai dengan 0,600 : cukup

Antara 0,200 sampai dengan 0,400 : rendah

Antara 0,000 sampai dengan 0,200 : sangat rendah
( Suharsimi Arikunto, 1992: 221)

G. Teknik Pengumpulan Data

Teknik pengumpulan data merupakan langkah yang paling utama
dalam suatu penelitian, karena tujuan utama dari penelitian adalah
mendapatkan data (Sugiyono, 2010: 308). Agar data yang data yang diperoleh
dalam penelitian ini merupakan data yang valid yaitu data yang diperoleh
merupakan gambaran sebenarnya dari kondisi yang ada.

Teknik pengumpulan data pada penelitian ini menggunakan observasi
dan dokumentasi, dengan tujuan untuk menentukan kelayakan media
pembelajaran Microsoft Excel berbasis multimedia. Observasi dilaksanakan
pada saat uji ahli media pembelajaran, uji ahli materi dan uji coba produk,
sedangkan teknik pengumpulan data dengan dokumentasi digunakan saat uji

coba pemakaian produk.

H. Analisis Data
Teknik analisis data dilakukan dengan menggunakan teknik analisis
deskriptif kuantitatif, yaitu dengan menganalisis data kuantitatif yang

diperoleh dari angket uji ahli dan uji lapangan. Menurut Suharsimi Arikunto
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(1992: 307), data kuantitatif yang berwujud angka-angka hasil perhitungan
atau pengukuran dapat diproses dengan cara dijumlah, dibandingkan dengan
jumlah yang diharapkan dan diperoleh persentase. Persentase ditentukan

dengan rumus sebagai berikut :

Skor yang diobservasi

Presentase Kelayakan (%) = X 100%
Skor yang diharapkan

Pencarian persentase dimaksudkan untuk mengetahui status sesuatu
yang dipersentasekan dan disajikan tetap berupa persentase, tetapi dapat juga
persentase kemudian ditafsirkan dengan kalimat yang bersifat kualitatif,
misalnya Sangat baik (76% - 100%), baik (56% - 75%), cukup (40% - 55%),

kurang baik (0 — 39%). Adapun keempat skala tersebut dapat ditulis sebagai

berikut :
Tabel 6. Presentase Pencapaian
Persentase Pencapaian Skala Nilai Interpretasi
76 — 100% 4 Sangat baik
56 —75% 3 Baik
40 - 55% 2 Cukup
0-39%% 1 Kurang baik

Tabel skala persentase di atas digunakan untuk menentukan nilai
kelayakan produk yang dihasilkan. Nilai kelayakan untuk produk media
pembelajaran Microsoft Excel berbasis multimedia ini ditetapkan kriteria

kelayakan minimal baik.
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BAB IV

HASIL PENELITIAN DAN PEMBAHASAN

Pembahasan Uji Ahli Materi dan Ahli Media
1. Hasil Uji Ahli Materi
Uji terhadap ahli materi menggunakan skala Likert dengan skor = 4
untuk penilaian sangat setuju, skor = 3 untuk penilaian setuju, skor = 2
untuk penilaian kurang setuju dan skor = 1 untuk penilaian tidak setuju.
Berdasarkan penilaian di atas maka skor hasil uji kelayakan sebagai

berikut.

Tabel 7. Hasil Persentase Ahli Materi

Skor
No Pernyataan S S KS TS
1 Media ini sudah terdapat pengenalan 4
" | tentang Microsoft Excel
Media ini sudah terdapat pengenalan
2. | berbagai menu dalam Microsoft 4
Excel
3 Media ini sudah menjelaskan fungsi 3
" | dari masing-masing ikon
4 Media ini sudah terdapat tutorial 3
" | untuk membuat lembar kerja
Media ini sudah terdapat penjelasan
5. | cara mengolah data dalam lembar 3
kerja
6 Media ini sudah menjelaskan rumus 3
" | dasar pada Microsoft Excel
Media ini terdapat penjelasan untuk
7. .. . 3
menyisipkan gambar lembar kerja
Media ini sudah terdapat penjelaskan
8 | untuk menyisipkan grafik dalam 3
lembar kerja
Jumlah 8 18
Persentase 81,25 %
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Berdasarkan pembobotan skala likert skor ideal adalah 4 x 8§ = 32,
(seandainya semua menjawab SS). Jumlah skor yang diperoleh dari
penelitian = 26. Jadi berdasarkan data itu maka tingkat persetujuan
kelayakan materi pada media pembelajaran = (26 : 32) x 100% = 81,25%
Berdasarkan kriteria yang telah ditetapkan termasuk dalam katagori
Sangat Baik
Secara kontinium dapat digambarkan seperti berikut :

TS KS S SS

] ] ] ] ]
8 11 16 26 32

Kekurangan dan saran dari program ini adalah pada saat validasi
dilakukan adalah pada materi 1 sebaiknya antara gambar dan
keterangannya diletakan berdampingan, serta menu latihan dan evaluasi
sebaiknya diberikan tombol untuk membatalkan misalnya cancel. Adapun

kekurangan dan saran di atas sudah diperbaiki.

Hasil Uji Ahli Media

Uji terhadap ahli media menggunakan skala Likert dengan skor = 4
untuk penilaian sangat setuju, skor = 3 untuk penilaian setuju, skor = 2
untuk penilaian kurang setuju dan skor = 1 untuk penilaian tidak setuju.
Berdasarkan penilaian di atas maka skor hasil uji kelayakan sebagai

berikut.
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Tabel 8. Hasil Persentase Ahli Media

Skor
No Pernyataan 3S S KS TS
1. Pemilihan font sudah tepat 3
2. Komposisi warna menarik 3
3. Kualitas gambar bagus 2
4. Letak button (tombol back, next, 3
home, exit, scrollbar) konsisten
5. Penggunaan warna konsisten 3
6. Pemilihan font konsisten 3
7. Tombol (back, next, home, exit, 3
scrollbar) sudah berfungsi dengan
baik
8. | Link sudah berfungsi dengan baik 3
0. Media pembelajaran membantu 3
belajar dengan fokus
10. | Media pembelajaran mempermudah 2
praktek Microsoft Excel
Jumlah 24 4
Persentase 70%

Berdasarkan pembobotan skala likert skor ideal adalah 4 x 10 = 40,
(seandainya semua menjawab SS). Jumlah skor yang diperoleh dari penelitian
= 28. Jadi berdasarkan data itu maka tingkat persetujuan kelayakan media
pada media pembelajaran = (28 : 40) x 100% = 70% Berdasarkan kriteria
yang telah ditetapkan termasuk dalam katagori Baik

Secara kontinium dapat digambarkan seperti berikut :

TS KS S SS

10 20 28 30 40

Kekurangan dan saran dari program ini adalah pada saat

validasi dilakukan adalah materi perlu diberi no halaman, scrolling
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sebaiknya dihindarkan, menampilkan pull-down menu sebaiknya
dibuat animasi atau pop —up, agar tidak seperti buku, latihan sebaiknya
diarahkan pada pencapaian kompetensi dasar dan dibuat interaktif.

Adapun kekurangan dan saran di atas sudah diperbaiki.

B. Desain Awal Produk
1. Hasil Tampilan Intro
Tampilan Intro merupakan tampilan pertama kali kita membuka
media pembelajaran Microsoft Excel untuk menuju ke bagian pentunjuk
penggunaan. Dalam intro juga terdapat judul media pembelajaran

Microsoft Excel. Implementasi tampilan intro adalah sebagai berikut :

Gambar 14. Tampilan Intro
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F Adabe Flash Player 9

Selamat Datang dalam

MEDIA PEMBELAJARAI

PENDIDIKAN TEKNIK INFORMATIKA
FAKULTAS TEKNIK
UNIVERSITAS NEGERI YOGYAKARTA

Gambar 15. Tampilan Intro dan Judul Media Pembelajaran Microsoft
Excel
Hasil Tampilan Petunjuk Penggunaan
Tampilan petunjuk penggunaan berisikan petunjuk penggunaan

media pembelajaran Microsoft Excel.

PENDAHULUAN

Agar berhasil menguasai materi ini, kalian
sebaiknya mempelajari secara berurutan.

. mulailah dengan pendahuluan.

! didalam menu PENDAHULUAN, kalian akan
mendapatkan gambaran tentang apa saja yang

harus dicapai setelah selesai mempelajari materi
ini Selanjutnya

MENU UTAMA

Gambar 16. Hasil Tampilan Petunjuk Penggunaan
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3. Hasil Tampilan Pengenalan Media Pembelajaran

Tampilan pengenalan media pembelajaran Microsoft Excel berisi

animasi dan pengenalan media pembelajaran Microsoft Excel.

Aplikasi Program Pengolah Angka Dengan

Micresoft Excel 2005

Gambar 17. Tampilan Pengenalan Media Pembelajaran

4. Hasil Tampilan Pendahuluan

Tampilan pendahuluan berisi kompetensi yang harus dicapai

berdasarkan pada kurikulum KTSP 2006.

KOMPETENSI
STANDAR KOMPETENSI :
Menerapkan perangkat lunak pengolah Angka (excell processing)
untuk menghasilkan informasi

KOMPETENSI DASAR :

1. Menunjukkan menu oo yang terdapat dalam perangkat lunak pengolah angka
2. Membuat dokumen pengola angka dengan variasi ieks, tabel, grafik, gambar dan diagram
3, Mengolah dokumen pengolah angka dengan variasi teks, tabel, grafik dan diagram

Gambar 18. Tampilan Pendahuluan
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5. Hasil Tampilan Materi
Tampilan materi berisi materi 1, materi 2, materi 3, materi 4

dan setiap materi berisi pokok bahasan masing-masing

g =
.t Anda berada di menu Materi .

Materi yang akan dipelajari dalam CD pembelajaran ini terdiri dari 4
maleri, materi | membahas fentang pendahuluan pengounaan MS
Excel, materi 2 membahas (entany berbagai rumus, fungsi dan
operalor, maleri 3 membahas (entang menyisipkan grafik dan gambar,
maleri 4 membahas tentang memanfaatkan fungsi logika. melalui
{opik-topik ini, media pembelajaran Ms Excel diharapkan dapal
menudukung kegialan pembelajaran siswa pada pembelajaran
malemaika dan yang lain.

Gambar 19. Tampilan Materi

a. Materi 1
1) Tampilan pendahuluan pada materi 1 berisikan pendahulan

tentang Microsoft Excel.

.t Anda berada di menu Materi 1 > Pendahuluan - Hal 1.1.1

Microseft FExcel adalah General Purpose
Electronic Spreadsheet yang bekerja dibawah
Sistem Operasi Windows. Microsoft Excel dapat

digunakan untuk menghitung angka-angka,
bekerja dengan daftar data, dan menganalisa
data-data serta mempresentasikannya ke dalam
bentuk grafik/diagram.

Gambar 20. Tampilan Pendahuluan pada Materi 1
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2) Tampilan pengenalan pada materi 1 ini, yang berisi

pengenalan tentang latar atau layout pada Microsoft Excel.

. Anda berada di menu Materi 1 > Pengenalan :. Hal 1.2.1
Pengenalan Layar Kerja MS Excel

Pada saat membuka program Microsoft Excel, kita langsung
disuguhi tampilan sebuah workbook.

Workbook adalah file yang berisi lembar kerja (worksheet)
Excel. pada saat kita baru mengaktifkan Excel untuk pertama

kali, workbook yang akan kita lihat adalah book] yang terdiri
dari 3 lembar kerja (sheet). Worksheet, atau disebut sheet,
merupakan dokumen utama yang dipakai untuk menyimpan
dan bekerja dengan data. Worksheet disebut juga spreadseet.
Worksheet terdiri dari atas sel-sel yang terbentuk dari
perpotongan kolom dan baris.

Gambar 21. Tampilan Pengenalan pada Materi 1
3) Tampilan manu pada materi 1 ini, yang berisi menu-menu

yang ada pada Microsoft Excel.

s beraa & mevst Saterd 1 > Maws © Mal 100
Menu Pada Microsoft Excel

Pada pembahasan ini. Anda akan mempelajari menu-menu
pada Microsoft Excel yang sering dipergunakan pada saat
bekerja dengan menggunakan Microsoft Excel. Sub-aub

menu yang terdapat pada menu Excel ini sesungguhnya
lebih  banyak lagi. adapun menu-menu yang sering
digunakan yaitu

Gambar 22. Tampilan Menu pada Materi 1
4) Tampilan ikon pada materi 1 ini, yang berisi pengenalan

tentang ikon-ikon pada Microsoft Excel.
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. Anda berada di mena Materi | > Ikon ;. Hal 1.4.1
Ikon Dasar yang Terdapat pada Excel

Untuk mempermudah penggunaan program, Excel telah
dilengkapi dengan Graphic User Interface (GUI), yaitu
suatu perintah yang ditunjukkan dengan menggunakan

simbol atau gambar wyang biasa discbut ikon. lkon
tersebutdapat digunakan hanya dengan | (satu) Klik pada
simbol atau gambar

Gambar 23. Tampilan Ikon pada Materi 1
5) Tampilan membuat dokumen pada materi 1 ini, yang berisi

materi tentang membuat dokumen pada Microsoft Excel

2 Anda beradn di menu Materi 1 > Membuat Dokamen @, Hal 1.5.1
Membuat Dokumen
Untuk membuat judul di tengah tabel maka dilakukan
langkah sebagai berikut ini :
= Ketik terlebih dahulu kata yang menjadi judul pada

kolom yang paling pertama (A...). Blok

kolom sampai ke kolom paling akhir tabel. Gunakan toolbar
merge and center seperti

dibawah ini.

Gambar 24. Tampilan Membuat Dokumen pada Materi 1
b. Materi 2
1) Tampilan pengolahan data pada materi 2 berisikan tentang

mengolah data angka pada Microsoft Excel.
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2 Anda berada di menu Materi 2 > Pengolahan Data :. Hal 2.1.1

Pengolahan Data
Pada bagian ini akan membahas bagaimana langkah-langkah untuk
mengolah data yang terdapat pada excel 2003. Pengolahan data disini
adalah bagaimana mengedit bagaimana memberi format pada cell atau

range tertentu dangan format penulisan yang diinginkan. Pada tahap ini
juga akan diberikan cara bagaimana mengolah tabel seperti memberi
warna pada Cell dan Border yang bervariasi. Terdapat juga pengaturan
format pengkondisian data seperti pemberian warna pada data sesuai
dengan pengaturan yang diberikan. untuk lebih jelas tentang apa yang
ingin disampaikan, mari ikuti beberapa penjelasan berikut

Gambar 25. Tampilan Mengolah Data pada Materi 2
2) Tampilan pengditan pada materi 2 berisikan tentang mengedit

data berupa angka pada worksheet.

ey
. Anda beradan di menu Materi 2 > Pengeditan ;. Hal 2.2.1
Pengeditan Worksheet
Pengeditan dapat dilakukan dengan tiga cara, yaitu :
1. Pilih sel yang datanya ingin diperbaiki, lalu tekan F2.
2. Double klik pada cell yang mau diedit

3. Mengedit pada Formula Bar

Gambar 26. Tampilan Pengeditan pada Materi 2
3) Tampilan pemformatan pada materi 2 berisikan tentang

pemformatan data pada worksheet.
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-2 Anda berada di menu Materi 2 > Pemformatan ;. Hal 2.3.1

Pemformatan Worksheet

Dalam pemformatan worksheet menggunakan Klik menu Format

1. Untuk menampilkan cells Klik menu Format > Cells...

2. Untuk menampilkan Row Klik menu Format > Row

3. Untuk menampilkan Column Klik menu Format = Column
5. Untuk menampilkan Sheet Klik menu Format > Sheet

Klik tombaol ini untuk mencoba == “

Gambar 27. Tampilan Pemformatan pada Materi 2
c. Materi 3
1) Tampilan pendahuluan pada materi 3 berisikan tentang

pendahuluan menggunakan rumus pada Microsoft Excel.

=
.+ Anda berada di menu Materi 3 > Pendahuluan -, Hal 3.1.1
Menggunakan Rumus pada Microsoft Excel
Penggunaan rumus pada microsoft excel merupakan suatu operasi matematika
dengan menggunakan sombol dan operasi matematika. Misalnya menjumlahkan
mengurangi, mangalikan dan operasi ika lain serta kombinasi di
operasi tersebut, untuk operasi atas bil bilangan tersebut, digunakan simbol

yang digunakan seperti halnya dalam operasi matematika maupun statistik.
Anda dapat memasukkan rumus yang berupa instruksi matematika ke dalam
suatu sel pada lembar kerja, Operator hitung yang dapat digunakan diantaranya

- A

adalah +  (penjumlahan), - (pengurangan), (perkalian),  dan
(perpangkatan).Pada Microsoft Excel, simbol-simbol yang digunakan untuk
operasi bilangan tersebut yaitu :

Gambar 28. Tampilan Pendahuluan pada Materi 3
2) Tampilan fungsi pada materi 3 berisikan tentang menggunakan

fungsi pada Microsoft Excel.
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g
. Anda berada di menu Materi 3 > Fungsi .. Hal 3.2.1
Operator Perhitungan MS Excel

Penjumlahan, pengurangan, perkalian, pembagian, dan kat

dilakukan dengan cara menuliskan alamat selnya bukan angkanya pada
formula bar. Misal :

Penjumlahan : =Al1+BI atau +A1+B1.
Pengurangan : =Al-Bl atau +A1-Bl.

Perkalian :=A1*Bl atau +A1*Bl.
Pembagian :=A1/B] atau +Al/Bl.

Pangkat2  :=Al"2 atau A1%2.

Gambar 29. Tampilan Fungsi pada Materi 3
d. Materi 4
1) Tampilan menyisipkan gambar pada materi 4 berisikan tentang

menyisipkan gambar pada Microsoft Excel.

. Anda berada di menu Materi 4 > Menggunakan gambar ;. Hal 4.1.1
Menggunakan Gambar
Agar dokumen yang dibuat lebih menarik, pada Microsoft Excel
memberikan fasilitas untuk menyisipkan gambar yang akan disisipkan
dapat berupa gambar ClipArt bawaan dari program Microsoft Excel,
maupun gambar dari file komputer yang berupa jpg, gif dan

sebagainya.

adapun langkah-langkahnya adalah
Pilih menu Insert > ClipArt

Pilih menu Insert > From File
Pilih menu Insert > WordArt

Pilih menu Insert >AutoShape

Gambar 30. Tampilan Menyisipkan Gambar pada Materi 4
2) Tampilan menyisipkan grafik pada materi 4 berisikan tentang

menyisipkan grafik pada Microsoft Excel.
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.
.+ Anda berada di menu Materi 4 > Menggunakan grafik :. Hal 4.2.1

Menggunakan Grafik
Microsoft Excel memberikan fasilitas untuk menyisipkan grafik,
adapun langkah-langkahnya adalah
1. Pilih menu Insert > Chart > pilih bentuk grafik yang diinginkan

. Tentukan sumber data
. Tuliskan judul grafik, nama sumbu X dan Y

4. Tentukan lokasi peletakan grafik yang akan dibuat
. Finish

Gambar 31. Tampilan Menyisipkan Grafik pada Materi 4

6. Hasil Tampilan Latihan

a. Hasil tampilan utama latihan

WELCOME
LATIHAN

Gambar 32. Tampilan Utama Latihan
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b. Tampilan latihan berisikan 10 soal pilihan ganda

Berikut merupakan fungsi dari program pengolah angka, kecuali...

A Untuk mengolah lembar kerja

B Untuk melakukan perhitungan f‘.&
/T_—_'. N E 3

C Untuk membuat database

D Untuk mengelola gambar

Gambar 33. Tampilan Soal Latihan
c. Tampilan hasil tes latihan
Pada tampilan hasil tes latihan, menampilkan hasil jawaban
yang benar dan hasil jawaban yang salah, dan skor untuk memberikan

nilai.

Congratulation pou finis the
- [
Quiz

CORRECT ANSWER

Gambar 34. Tampilan Hasil Latihan
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7. Hasil Tampilan Evaluasi

a. Hasil tampilan utama evaluasi

WELCOME
TO QUIZ

Gambar 35. Tampilan Utama Evaluasi

b. Tampilan evaluasi berisikan 15 soal pilihan ganda

Pada Microsoft Excel, area kerja pada program tersebut disebut sebagai...

A Worksheet

B Workbook

C slide
D Panel

Gambar 36. Tampilan Soal Evaluasi
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c. Tampilan hasil tes evaluasi
Pada tampilan hasil tes evaluasi, menampilkan hasil
jawaban yang benar dan hasil jawaban yang salah, dan skor untuk

memberikan nilai.

Congratulation pou finis the
Quiz

CORRECT ANSWER 9

INCORREH ANSWER §5

Gambar 37. Tampilan Hasil Evaluasi
8. Hasil Tampilan Profil
Tampilan profil terdapat informasi biodata pembuat media

pembelajaran Microsoft Excel.
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Gentan Sloman Yogyakarta

Pondidikan : TK Alvyah Mataram, SON 24 Mataram,|

‘SMPHN 4 Motaram, SMA 1 Cangkringan
Slaman Yogyakarta, Universitas Negori
Yogyakarta

Kontak  : 085842058459
Blog : www buchorisilver. blogspat.com
Email : buchorisilver@rocketmall com

Gambar 38. Tampilan Profil

Apakah Kamu Benar-benar
ingin keluar ?

X @

Gambar 39. Tampilan Exit
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C. Pembahasan Analisis Instrumen

1. Validitas

Sebuah tes dikatakan memiliki validitas jika hasilnya sesuai dengan
kriterium, dalam arti memiliki kesejajaran antar hasil tes tersebut dengan
kriterium. Teknik yang digunakan untuk mengetahui kesejajaran adalah teknik
korelasi product moment. Validitas item adalah demikian sebuah item yang
dikatakan valid apabila mempunyai dukungan yang besar terhadap skor total.
Skor pada item menyebabkan skor total menjadi tinggi atau rendah. Dengan
kata lain dapat dikemukakan disini bahwa sebuah item memiliki validitas yang
tinggi jika skor pada item mempunyai kesejajaran dengan skor total.
Kesejajaran ini dapat diartikan dengan korelasi sehingga untuk mengetahui
validitas item digunakan rumus korelasi.

Rumus korelasi product moment dengan angka kasar

_ NIXY - CEXQEY) 1
VINZX? - CX)INZY? -3

Ty y

ryy = koefisien korelasi antara variable x dan variable y, dua variable
yang dikorelasikan

2= jumlah perkalian x dengan y

2= jumlah dari x

Xy =jumlah dariy

»X? = jumlah kuadrat dari x

>Y? = jumlah kuadrat dari y
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Tabel 9. Hasil Validitas Instrumen

No Jawaban Angket E EY?
Res Y
1 2 3 4 5 6 7 8 9 10 11 12 13
1 3 4 2 2 3 4 2 1 4 4 3 4 4| 40 | 1600
2 3 4 3 3 3 3 2 4 4 4 3 4 4| 44| 1936
3 3 3 3 3 3 3 2 2 1 3 3 4 41 37| 1369
4 3 3 3 3 3 1 2 2 4 4 4 3 3| 38| 1444
5 3 3 3 3 3 3 2 3 1 3 2 1 3| 33| 1089
6 4 4 4 4 4 3 3 4 4 4 4 4 41 50| 2500
7 4 4 4 4 4 4 3 4 3 4 4 4 4| 50| 2500
8 3 3 3 3 3 4 4 4 4 4 4 3 3 45| 2025
9 3 3 3 3 3 4 4 4 4 4 4 3 3| 45| 2025
10 3 3 3 3 3 4 4 3 3 4 3 4 41 44| 1936
11 3 4 3 3 3 4 4 3 4 4 3 3 4| 45| 2025
12 4 3 3 3 3 2 3 3 2 2 3 3 3] 37| 1369
13 3 3 3 3 3 2 2 3 2 4 3 4 3 38| 1444
14 4 4 4 3 3 1 3 3 3 3 3 2 4| 40 | 1600
15 4 4 4 4 4 4 3 4 4 4 4 4 4|1 51| 2601
16 3 3 3 3 3 3 3 3 4 3 3 2 3] 39| 1521
17 4 4 4 3 3 2 3 4 4 4 4 3 3] 45| 2025
18 3 3 3 3 3 2 2 3 4 3 4 3 31 39| 1521
19 3 4 3 3 3 3 2 3 3 4 4 4 3| 42| 1764
EX 63 66 61 59 60 56 53 60 62 69 65 62 66
Ex? 213 | 234 | 201 187 192 | 184 | 159 | 202 | 222 | 257 | 229 | 216 | 234
EXY | 2679 | 2813 | 2602 | 2517 | 2557 | 2411 | 2274 | 2581 | 2672 | 2946 | 2778 | 2657 | 2807
EY 802
EY? 34294
Xy 046 | 059 | 057 | 065| 073 | 052 | 053] 065| 059 | 063 | 063 | 051 | 046
Ket | valid | Valid | Valid | Valid | Valid | Valid | Valid | Valid | Valid | Valid | Valid | Valid | Valid

Dengan r table product moment n:19 = 0,456
Hasil pengujian validitas instrumen ini dengan cara mencari
korelasi product moment dari masing-masing item instrumen kemudian
diinteprestasikan dengan (r) table dengan n=19 sebesar 0,456, dengan hasil
bahwa semua item/butir soal dalam instrumen itu valid. Pada penelitian ini
peneliti menggunakan validitas logis yaitu instrumen itu dikonsultasikan
kepada ahli atau dosen yang berkompeten. Data ujicoba dilakukan pada 21

Mei 2011.
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2. Reliabilitas

Dalam persyaratan tes, bahwa reliabilitas berhubungan dengan
masalah kepercayaan. Suatu tes dapat dikatakan mempunyai taraf kepercayaan
tinggi jika tersebut dapat memberikan hasil yang tetap. Maka pengertian
reliabilitas tes, berhubungan dengan masalah ketetapan hasil tes. Sendainya
hasilnya berubah-ubah maka perubahan yang terjadi dapat dikatakan tidak
berarti.

Untuk mencari reliabilitas soal keseluruhan perlu juga dilakukan
analisis butir soal seperti halnya soal bentuk obyektif. Skor untuk masing-
masing butir soal dicantumkan pada kolom item menurut apa adanya.

Tabel 10. Hasil Reliabilitas Instrumen

No Res Jawaban Angket Total K}'ﬁ?;at
1 2 3 4 5 6 7 8 9| 10| 11| 12| 13

1 3 4 2 2 3 4 2 1 4 4 3 4 4 40 1600

2 3 4 3 3 3 3 2 4 4 4 3 4 4 44 1936

3 3 3 3 3 3 3 2 2 1 3 3 4 4 37 1369

4 3 3 3 3 3 1 2 2 4 4 4 3 3 38 1444

5 3 3 3 3 3 3 2 3 1 3 2 1 3 33 1089

6 4 4 4 4 4 3 3 4 4 4 4 4 4 50 2500

7 4 4 4 4 4 4 3 4 3 4 4 4 4 50 2500

8 3 3 3 3 3 4 4 4 4 4 4 3 3 45 2025

9 3 3 3 3 3 4 4 4 4 4 4 3 3 45 2025

10 3 3 3 3 3 4 4 3 3 4 3 4 4 44 1936

11 3 4 3 3 3 4 4 3 4 4 3 3 4 45 2025

12 4 3 3 3 3 2 3 3 2 2 3 3 3 37 1369

13 3 3 3 3 3 2 2 3 2 4 3 4 3 38 1444

14 4 4 4 3 3 1 3 3 3 3 3 2 4 40 1600

15 4 4 4 4 4 4 3 4 4 4 4 4 4 51 2601

16 3 3 3 3 3 3 3 3 4 3 3 2 3 39 1521

17 4 4 4 3 3 2 3 4 4 4 4 3 3 45 2025

18 3 3 3 3 3 2 2 3 4 3 4 3 3 39 1521

19 3 4 3 3 3 3 2 3 3 4 4 4 3 42 1764

Jumlah 63| 66| 61| 59| 60 s6| s3] 60| 62| 6| 65| 6| 66| 802 34204
Euadrat 213 | 234 | 201 | 187 | 192 184 | 159 | 202 | 222 | 257 | 220 | 216 | 234
p\e'fﬁzﬁl 022 | 025|027 | 02 | 013 | 0997 | 059 | 0.66 | 1.04 | 034 | 035 | 0.72 | 0.25
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Rumus yang digunakan adalah rumus Alpha sebagai berikut

= {{ﬂ:})“ -

Menghitung total varian butir (20;°) =

2 _ o _ (EX2)
of! IXx® ,FEE
]

=0,22
Jumlah varians semua butir (26> =
0,22+0,25+0,27+0,2+0,13+0,997+0,59+0,66+1,04+0,34+0,35+0,72+0,25
=6,0055401
Varian total (6%) =

34294 — B‘;j g‘

o2 = 19
=23,2188

Rumus alpha

= (ﬁ)ﬁ _%23

:{' 13 :I": _ 6005540
£13 =1} 23,2188
=0,8313
Dengan diperolehnya koefisien korelasi yakin r;; sebenarnya baru
diketahui tinggi-rendahnya koefisien tersebut. Lebih sempurnanya
penghitungan relibilitas sampai pada kesimpulan, hasil tersebut

dikonsultasikan dengan table r product moment . Sedangkan hasil

pengujian reliabilitas instrumen memperoleh nilai Alpha sebesar
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0,8031293, nilai Alpha > 0,456 dengan n=19 pada table r product moment

mengindikasikan instrumen pada penelitian ini reliable. Data ujicoba

dilakukan pada 21 Mei 2011.

D. Pembahasan Data Evaluasi

Data evaluasi ini berupa data uji coba lapangan. Uji coba lapangan

dilakukan tanggal 28 Mei 2011 di SMA Negeri 1 Ngemplak sebanyak 78

siswa. Hasil dari uji coba lapangan diperoleh 7 aspek, yaitu menu ikon,

pengolah data,

edit tampilan, tampilan desain, konsistensi, navigasi,

kemanfaatan. Data ini dikaji untuk mengetahui tanggapan siswa terhadap

media. Data analisis media selengkapnya dapat dijelaskan sebagai berikut dan

mengacu Sangat baik (76% - 100%), baik (56% - 75%), cukup (40% - 55%),

kurang baik (0 - 39%).

Tabel 11. Pembahasan Presentase Ujicoba Lapangan

No Aspek Indikator Hasil Penjelasan

1. | Menu ikon Membantu Pada aspek | Membuktikan
pemahaman tentang | ini, bahwa
fungsi masing- | diperoleh didapatkan
masing ikon dalam | hasil interpretasi
Microsoft Excel 87.,5% sangat baik

2. Membantu untuk | Pada aspek | Membuktikan
mempermudah ini, bahwa
membuat lembar | diperoleh | didapatkan




kerja dalam | hasil interpretasi
Microsoft Excel 85,89% sangat baik

Pengolah Membantu Pada aspek | Membuktikan

data pemahaman tantang | ini, bahwa
penggunaan rumus- | diperoleh | interpretasi
rumus dasar dalam | hasil sangat baik
Microsoft Excel 81,41%

Edit tampilan | Mempermudah Pada aspek | Membuktikan
langkah untuk | ini, bahwa
menyisipkan gambar | diperoleh | interpretasi
pada lembar kerja | hasil sangat baik
Microsoft Excel 82,05%.

Mempermudah Pada aspek | Membuktikan
langkah untuk | ini, bahwa
menyisipkan grafik | diperoleh | interpretasi
pada lembar kerja | hasil sangat baik
Microsoft Excel 83,97%.

Tampilan Menggunakan font | Pada aspek | Membuktikan

desain yang sudah tepat ini, bahwa

diperoleh | interpretasi
hasil sangat baik
81,08%

Menggunakan Pada aspek | Membuktikan

79



warna-warna  yang | ini, bahwa

seimbang diperoleh | interpretasi
hasil sangat baik.
76,28%

8 Disisipi gambar yang | Pada aspek | Membuktikan
mampu memperjelas | ini, bahwa
materi tentang | diperoleh | interpretasi
Microsoft Excel hasil sangat baik

81,08%

9. | Konsistensi | Mempunyai tombol- | Pada aspek | Membuktikan
tombol yang | ini, bahwa
letaknya konsisten diperoleh | interpretasi

hasil sangat baik
81,17%

10. | Navigasi Mempunyai tombol- | Pada aspek | Membuktikan
tombol yang | ini, bahwa
berfungsi dengan | diperoleh | interpretasi
benar hasil sangat setuju

86,21%

11. Mempunyai fasilitas | Pada aspek | Membuktikan
link yang berfungsi | ini, bahwa
dengan benar diperoleh | interpretasi

hasil sangat baik

80
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87,82%
12. | Kemanfaatan | Membantu fokus | Pada aspek | Membuktikan
dalam belajar | ini, bahwa
Microsoft Excel diperoleh | interpretasi
hasil sangat baik
87,5%
13. Mempermudah Pada aspek | Membuktikan
praktik Microsoft | ini, bahwa
Excel diperoleh | interpretasi
hasil sangat baik
84,93%

Penelitian kelayakan media pembelajaran dalam uji ahli dan uji coba
produk pada penelitian ini menggunakan angket sebagai instrument
penilaiannya. Skala yang digunakan dalam tersebut menggunakan skala likert
yaitu dengan skor penelitian 1 sampai 4. Skor 1 berarti kurang baik, skor 2
berarti cukup, skor 3 berarti baik dan skor 4 berarti sangat baik. Selanjutnya
data yang terkumpul diproses dengan cara dujumlahkan, dibandingkan
dengan jumlah yang diharapkan dan diperoleh persentase. Kriteria penilaian
kelayakan media pembelajaran yaitu 0-39 % berarti kurang baik, 40-55 %
cukup, 56-75 % berarti baik dan 76-100 % berarti sangat baik.

Berdasarkan data validasi ahli materi dan ahli media serta uji coba

lapangan, maka media pembelajaran Microsoft Excel yang dibuat ini layak
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digunakan dan dimanfaatkan sebagai salah satu suplemen pembelajaran.
Disamping itu dengan menggunakan media pembelajaran Microsoft Excel
menjadi lebih efektif. Materi yang dibuat sudah sesuai dengan standar
kompetensi dan kompetensi dasar.

Hasil penilaian pada uji coba produk yang dibagi menjadi tujuh aspek
yaitu aspek menu ikon, pengolah data, edit tampilan, tampilan desain,
konsistensi, navigasi, kemanfaatan. Aspek menu ikon memperoleh persentase
sebesar 86,69 % termasuk dalam kategori sangat baik, aspek pengolah data
memperoleh persentase sebesar 81,41 %, aspek edit tampilan memperoleh
persentase sebesar 83,01 % termasuk kategori sangat baik, aspek tampilan
desain memperoleh persentase sebesar 79,48 % termasuk kategori sangat
baik, aspek konsistensi memperoleh pesentasi sebesar 81,17 % termasuk
kategori sangat baik, aspek navigasi memperoleh pesentasi sebesar 87,01 %
termasuk kategori sangat baik, dan aspek konsistensi memperoleh pesentasi
sebesar 86,21 % termasuk kategori sangat baik. Secara keseluruhan hasil
penilaian siswa memperoleh persentase sebesar 83,56 % termasuk dalam
kategori sangat baik.

Sehingga dapat disimpulkan bahwa media pembelajaran layak
digunakan sebagai media pembelajaran karena memiliki kualitas yang sangat
baik untuk mendukung pembelajaran teknologi informasi dan komunikasi

yaitu Microsoft Excel.
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E. Komentar Dan Saran Pada Uji Lapangan
Secara umum komentar dan saran dalam uji coba lapangan dapat
disimpulkan sebagai berikut :
a. Secara umum media pembelajaran Microsoft Excel dinilai sudah
baik.

b. Kualitas tampilan gambar pada media yang kurang baik
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DIIJINKAN untuk melakukan kegiatan survei/penelitian/pendataan/pengembangan/pengkajian/studi lapahgan *)
kepada :

Naina : AGUS BUCHORI NIP/NIM

07520244036
Alamat " Karangmalang, Yogyakarta

Judul " MEDIA PEMBELAJARAN PENGENALAN DASAR KOMPUTER KELAS X SEKOLAH MENENGAH
ATAS (SMA) BERBASIS MULTIMEDIA

Lokasi ' Kab. Sleman .

Waktu : 3 (tiga) Bulan Mulai tanggal * 11 Mei s/d 11 Agustus 2011

Dengan ketentuan :

1. Menyerahkan surat keterangan/ijin survei/penelitian/pendataan/pengembangan/pengkajian/studi lapangan N
dari Pemerintah Provinsi DIY kepada Bupati/Walikota melalui institusi yang berwenang mengeluarkan ijin
dimaksLd;

2. Menyerahkan softcopy hasil penelitiannya kepada Gubernur Daerah Istimewa Yogyakarta melalui Biro
Administrasi Pembangunan Setda Provinsi DIY dalam compact disk (CD) dan menunjukkan cetakan asli yang
sudah disahkan dan dibubuhi cap institusi;

3. ljin ini hanya dipergunakan untuk keperluan ilmiah, dan pemegang ijir wajib mentaati ketentuan yang perlaku di
lokasi kegiatay,

4. ljin penelitian apat diperpanjang dengan mengajukan suratini kembali sebelum berakhir waktunya;

5. ljin yeng dibeikan dapat dibatalkan sewakt.-waktu apabila pemegang ijin ini tidak memenuhi ketentuan yang
berlak 1.

Tembusan disampaikan kepada Yth.
1. Gubernur Duerah Istimewa Yegyakarta (sebagai laporan);

2. Bupati Sleman Cq. Ka. Bappeda

3. Ka. Dinas Pendidikan, Pemuda dan Olahraga Provinsi DIY -
4. Dekan Fak. Teknik UNY

5. Yang Bersangkutan
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PEMERINTAH KABUPATEN SLEMAN
BADAN PERENCANAAN PEMBANGUNAN DAERAH

( BAPPEDA )

Alamat : JI. Parasamya No. 1 Beran, Tridadi, Sleman 55511
Telp.& Fax. (0274) 868800 e-mail : bappeda@slemanKab.go.id

SURAT PERNYATAAN BERSEDIA MENYERAHKAN
HASIL - HASIL SURVEY/PENELITIAN
NO.:070/ |3

Kami yang bertanda tangan dibawah ini saya:

1.Nama - R S

2.No. Mahasiswa/NIP/NIM - Q7520294 ¢ 036

3. Tingkat (D1, D2, S1,52, S3) . o).

4. Universitas/Akademi ' s UNQ

5.Dosen Pembimbing 75 Prs -{V@ddﬂsmqn ’TT

6. Alamat Rumah Peneliti s et M. 10 Emp
Neman Y4

7.No. Telp/HP :...088 €42, mg ‘]‘57

8. Tempat Lokasi Penelitian/ Survey : .. SMA WY N@EWLA*"

Menyatakan dengan ini kami bersedia untuk menyerahkan hasil - hasil Research/ Penelitian/
pencanan data ntang/ Jjudul:

zmb g{q;\rcm j ngendlan Payar domputer Atelas ¥

Tk o, M;nma Lo, (? Ma). ?»ccrbom Nuthmeeha

Kepada BAPPEDA Kabupaten Sleman
Pernyataan ini merupakan bagian yang tidak terlepas dari
Pemnyataan perijinan Research/Penelitian yang kami lakukan dalam
Wilayah Kabupaten Sleman DIY.

Sleman, 2. Mg\ 2041
Yang menyatakan

(Nama Terang)
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PEMERINTAH KABUPATEN SLEMAN
BADAN PERENCANAAN PEMBANGUNAN DAERAH

( BAPPEDA )

Alamat : JI. Parasamya No. | Beran, Tridadi, Sleman 55511
Telp. & Fax. (0274) 868800. E-mail : bappeda@slemankab.go.id

SURAT IZIN
Nomor : 07.0 / Bappeda/ 1378 / 2011

TENTANG
PENELITIAN

KEPALA BADAN PERENCANAAN PEMBANGUNAN DAERAH

Dasar ¢ Keputusan Bupati Sleman Nomor: 55 /Kep.KDH/A/2003 tentang Izin Kuliah Kerja
Nyata, Praktek Kerja Lapangan dan Penelitian.
Menunjuk ¢ Surat dari Sekretariat Daerah Pemerintah Provinsi Daerah Istimewa Yogyakarta Nomor:

070/3905/V/2011 Tanggal: 11 Mei 2011. Hal: Izin Penelitian.

MENGIZINKAN :

Kepada :

Nama : AGUS BUCHORI

No. Mhs/NIM/NIP/NIK ;07520244036

Program/ Tingkat : Sl

Instansi/ Perguruan Tinggi : UNY.

Alamat Instansi/ Perguruan Tinggi : Karangmalang, Sleman, Yogyakarta

Alamat Rumah ¢ JI Kaliuran Km. 10 Gentan, Sleman, Yogyakarta

No. Tlp/ HP : 08584205 8459

Untuk ¢ Melakukan Penelitian dengan judul:
"MEDIA PEMBELAJARAN PENGENALAN DASAR
KOMPUTER KELAS X SEKOLAH MENENGAH ATAS (SM.A)
BERBASIS MULTIMEDIA “

Lokasi :  Kab. Sleman

Waktu : Selama 3 (tiga) bulan mulai tanggal : 11 Mei 2011 s/d

11 Agustus 2011.

Dengan ketentuan sebagai berikut :

1. Wajib melapor diri kepada Pejabat Pemerintah setempat (Camat/ Lurah Desa) atau Kepala Instansi untuk
mendapat petunjuk seperlunya.

2. Wajib menjaga tata tertib dan mentaati ketentuan-ketentuan setempat yang berlaku.
3

Wajib menyampaikan laporan hasil penelitian berupa 1 (satu) CD format PDF kepada Bupati diserahkan
melalui Kepala Bappeda.

4. Izin tidak disalahgunakan untuk kepentingan-kepentingan di luar yang direkomendasikan.
5. Izin ini dapat dibatalkan sewaktu-waktu apabila tidak dipenuhi ketentuan-ketentuan di atas.

Demikian izin ini dikeluarkan untuk digunakan sebagaimana mestinya, diharapkan pejabat
pemerintah/non pemerintah setempat memberikan bantuan seperlunya.

Setelah selesai pelaksanaan penelitian Saudara wajib menyampaikan laporan kepada kami 1 (satu) bulai
setelah berakhirnya penelitian.

.Dikeluarkan di : Sleman
Pada Tanggal : 12 Mei 2011

Tembusan Kepada Yth : A.n. Kepala BAPPEDA Kab. Sleman

1. Bupati Sleman (sebagai laporan). Ka. Bidang Pengendalian & Evaluasi
2.  Ka. Badan Kesbanglimas & PB Kab Sleman. g u.b.

3. Ka. Dinas Pendidikan, Pemuda & OR Sleman Ka. Sub Bid. Litbang

4.  Ka. Bid. Sosbud Bappeda Kab. Sleman - -

5. Camat Kec. Ngemplak AP~

6. Ka.SMA N 1 Ngemplak —%

b e TS TN, SRINURHIDAVAH. S Si MT



LAMPIRAN

2. Storyboard Media
Pembelajaran



Slide 1 Intro
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STORY BOARD MEDIA Keterangan navigasi :

Keterangan Tampilan :
Tampilan intro ini merupakan frame pertama

Keterangan Gambar, Animasi, Musik :

Logo : terdapat pada layar utama animasi membuka slide
Animasi Sliding : animasi sliding ini akan muncul saat media diklik
atau dibuka




Slide 2 Judul
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Keterangan navigasi :

PEMBUKAAN

Tombol Volume : untuk mengatur
suara
Tombol Enter : akan masuk

JUDUL

Disusun Oleh

menuju frame petunjuk
penggunaan

ENTER

Keterangan Tampilan :

Tampilan intro ini merupakan frame pertama

Keterangan Gambar, Animasi, Musik :

Gambar : terdapat pada background yang terdapat arti yaitu 1.
Rektorat UNY merupakan tempat menggali ilmu di bidang teknik dan
kependidikan, 2. Laptop merupakan alat teknologi untuk
menemukan dan mencari informasi apapun. 3. Web, merupakan
tempat sumber informasi

Musik : Linkin Park — new devide digunakan untuk menambah
semangat

Animasi : pada saat judul muncul merupakan animasi teks




Slide 3 Petunjuk Penggunaan
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Keterangan navigasi :

HEADER

Tombol Next : untuk melanjutkan
petunjuk penggunaan media
pembelajaran

Tombol Menu Utama : akan masuk

Petunjuk Penggunaan

menuju frame Pengenalan

Menu Utama

Keterangan Tampilan :
Tampilan petunjuk penggunaan berisikan petunjuk untuk
menggunakan media pembelajaran ini.

Keterangan Gambar, Animasi, Musik :

Animasi : pada halaman petunjuk penggunaan menggunakan
animasi masking

Gambar : terdapat logo UNY

Musik : Dewa bujana — Bunga Malam merupakan musik instrumen
yang mengandung unsur budaya, dan musiknya sederhana




Slide 4 Pengenalan Media Pembelajaran

97

HEADER

Aplikasi Program Pengolah Angka
Microsft Excel 2003
Berdasarkan KTSP 2006

PENGEMBANG

Pendahuluan Materi Latihan Evaluasi

Profil

Exit

Keterangan navigasi :

Tombol Pendahuluan : untuk
menuju frame Pendahuluan

Tombol Materi : untuk menuju
frame Materi

Tombol Latihan : untuk menuju
frame Latihan

Tombol Evaluasi : untuk menuju
frame Evaluasi

Tombol Profil : untuk menuju
frame Profil

Tombol Exit : untuk menuju frame
Exit

Keterangan Tampilan :
Pada tampilan ini menjelaskan judul , tampilan animasi yang
menggambarkan judul, beserta judul yang berdasarkan KTSP

Keterangan Gambar, Animasi, Musik :
Gambar : gambar yang digunakan adalah gambar versi-versi

2006 Microsoft excel yang mana untuk mengetahui sejarah Microsoft

excel

Animasi : menggunakan animasi Guide Motion, yang mana gambar
akan mengikuti guide yang kita buat, animasi ini digunakan agar
media ini lebih menarik.

Disini juga terdapat animasi pada teks

Musik : menggunakan Bouling Four Soup — Almous. Untuk
menambah semangat




Slide 5 Pendahuluan
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Keterangan navigasi :

HEADER

Tombol Pendahuluan : untuk
menuju frame Pendahuluan

Tombol Materi : untuk menuju

KOMPETENSI

Standar Kompetensi

Kompetensi

frame Materi

Tombol Latihan : untuk menuju
frame Latihan

Tombol Evaluasi : untuk menuju
frame Evaluasi

Tombol Profil : untuk menuju
frame Profil

Tombol Exit : untuk menuju frame

Exit

Pendahuluan Materi Latihan Evaluasi

Exit
Profil

Keterangan Tampilan :
Tampilan Pendahuluan ini berisi Kompetensi beserta Standar
Kompetensi dan Kompetensi Dasarnya

Keterangan Gambar, Animasi, Musik :

Animasi : terdapat animasi ada teks pada Kompetensi

Musik : Linkin Park —in the ends digunakan untuk menambah
semangat




Slide 6 (Materi)
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Keterangan navigasi :

HEADER

Tombol Pendahuluan : untuk
menuju frame Pendahuluan

Tombol Materi : untuk menuju

frame Materi

o) >
Lo ) >

Tombol Latihan : untuk menuju
frame Latihan

Tombol Evaluasi : untuk menuju
frame Evaluasi

Tombol Profil : untuk menuju

Enp

frame Profil

Tombol Exit : untuk menuju frame

Exit

Pendahuluan Materi Latihan Evaluasi

Exit
Profil

Keterangan Tampilan :
Pada tampilan materi ini, akan memuat beberapa tombol materi,
ada menu materi 1, materi 2, materi 3, materi 4

Keterangan Gambar, Animasi, Musik :

Animasi : pada baground tombol meteri terdapat animasi slide satu
persatu bermunculan begitu juga pada animasi tombol
Pendahuluan, Materi, Latihan, Evaluasi, Profil, Exit.

Musik : tidak ada karena akan mengganggu pembelajaran.




100

Slide (Materi 1) Keterangan navigasi :
HEADER Tombol Pendahuluan : untuk
menuju frame Pendahuluan
Tombol Materi : untuk menuju
f pendahuluan ) frame Materi
> { Pendahuluan
Pengenalan Tombol Latihan : untuk menuju
> . frame Latihan
Menu
h . Tombol Evaluasi : untuk menuju
Icon frame Evaluasi
[ Membuat Judul ] Tombol Profil : untuk menuju
M frame Profil
Tombol Exit : untuk menuju frame
Exit
Profil
Pendahuluan Materi Latihan Evaluasi Profil
Home : kembali ke Frame Materi
Keterangan Tampilan : Keterangan Gambar, Animasi, Musik :

Pada tampilan materi satu terdapat beberapa menu materi untuk
pendahuluan, pengenalan, menu, ikon, membuat judul

Beser tombol home untuk mejadi central menu materi
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Slide (Pengenalan) Keterangan navigasi :

HEADER Tombol Pendahuluan : untuk
menuju frame Pendahuluan

Tombol Materi : untuk menuju

Pendahuluan frame Materi

> Z Pengenalan

| Pengenalan ) Tombol Latihan : untuk menuju
p | frame Latihan

Menu
- \ Tombol Evaluasi : untuk menuju
| Icon ) frame Evaluasi
[ Membuat Judul ] : : Tombol Profil : untuk menuju

" frame Profil

Tombol Exit : untuk menuju frame

Profil Exit
Pendahuluan Materi Latihan Evaluasi Profil
Home : kembali ke Frame Materi
Keterangan Tampilan : Keterangan Gambar, Animasi, Musik :

Tampilan ini merupakan tampilan frame pengenalan pada materi 1
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Slide (Materi 2) Keterangan navigasi :

HEADER Tombol Pendahuluan : untuk
menuju frame Pendahuluan

Tombol Materi : untuk menuju

[ Pengolahan Data ] frame Materi
Pengolahan Data

Pengeditan dan Pemformatan Tombol Latihan : untuk menuju
frame Latihan

[ Pengeditan ]

Tombol Evaluasi : untuk menuju
[ Pemformatan ] frame Evaluasi

Tombol Profil : untuk menuju
M frame Profil

Tombol Exit : untuk menuju frame

Profil Exit
Pendahuluan Materi Latihan Evaluasi Profil
Home : kembali ke Frame Materi
Keterangan Tampilan : Keterangan Gambar, Animasi, Musik :

Pada tampilan ini merupakan tampilan materi 2
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Slide (Materi 3) Keterangan navigasi :

Tombol Pendahuluan : untuk
HEADER menuju frame Pendahuluan
Tombol Materi : untuk menuju
frame Materi

[ Pendahuluan ]

Pendahuluan Tombol Latihan : untuk menuju
[ Fungsi ] frame Latihan

Tombol Evaluasi : untuk menuju
frame Evaluasi

Tombol Profil : untuk menuju
frame Profil

Tombol Exit : untuk menuju frame

Exit
Profil
Pendahuluan Materi Latihan Evaluasi Profil Home : kembali ke Frame Materi
Keterangan Tampilan : Keterangan Gambar, Animasi, Musik :

Pada tampilan ini merupakan tampilan materi 3
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Slide (Materi 4) Keterangan navigasi :

HEADER Tombol Pendahuluan : untuk
menuju frame Pendahuluan

Tombol Materi : untuk menuju
[ Gambar ] frame Materi

Pendahuluan

[ Grafik ] Tombol Latihan : untuk menuju
frame Latihan

Tombol Evaluasi : untuk menuju
frame Evaluasi

Tombol Profil : untuk menuju
frame Profil

Tombol Exit : untuk menuju frame

Profil Exit
Pendahuluan Materi Latihan Evaluasi Profil
Home : kembali ke Frame Materi
Keterangan Tampilan : Keterangan Gambar, Animasi, Musik :

Pada tampilan ini merupakan tampilan materi




Slide (Latihan)
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Keterangan navigasi :

WELCOME TO
LATIHAN

Keterangan Tampilan

Tampilan awal pada saat latihan

Keterangan Gambar, Animasi, Musik :




Slide (Latihan)
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Question

No. 1 Soal..

KEMBALI

Keterangan navigasi :

A.

Tombol kembali digunakan untuk

Merupakan tombol yang
mana ketika dipilih akan
muncul keterangan hasil
benar atau salah

Merupakan tombol yang
mana ketika dipilih akan
muncul keterangan hasil
benar atau salah

Merupakan tombol yang
mana ketika dipilih akan
muncul keterangan hasil
benar atau salah

Merupakan tombol yang
mana ketika dipilih akan
muncul keterangan hasil
benar atau salah

ke menu utama

Keterangan Tampilan :
Tampilan intro ini merupakan frame pertama

Keterangan Gambar, Animasi, Musik :




Slide (Latihan)
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Keterangan navigasi :

CONGRATULATION FINISH LATIHAN mengulangi menjawab soal
evaluasi
correCt Answer . Tombol Im Back : untuk kembali ke
menu utama
Incorrect Answer :
Score :

Tombol Try Again : untuk

Try Im

Again Back

Keterangan Tampilan :

Hasil latihan ini terdapat skor penilaian nilai benar dan nilai yang
salah serta score yang diperoleh

Keterangan Gambar, Animasi, Musik :




Slide (Quiz)
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Keterangan navigasi :

WELCOME TO
QUIZ

Keterangan Tampilan :

Tampilan awal pada saat memasuki evaluasi

Keterangan Gambar, Animasi, Musik :




Slide (Quiz)
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Keterangan navigasi :

Question

No. 1 Soal....

A. Merupakan tombol yang
mana ketika dipilih akan
muncul keterangan hasil
benar atau salah

B. Merupakan tombol yang
mana ketika dipilih akan
muncul keterangan hasil
benar atau salah

C. Merupakan tombol yang
mana ketika dipilih akan
muncul keterangan hasil
benar atau salah

D. Merupakan tombol yang

mana ketika dipilih akan
[ Kembali ] muncul keterangan hasil
benar atau salah

Tombol kembali digunakan untuk
ke menu utama

Keterangan Tampilan :

Tampilan soal pada frame evaluasi

Keterangan Gambar, Animasi, Musik :
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Keterangan navigasi :

Slide Quis
CONGRATULATION FINISH QUIS evaluasi
Correct Answer :
Incorrect Answer :
Score :

Tombol Try Again : untuk
mengulangi menjawab soal

Tombol Im Back : untuk kembali ke
menu utama

Again

Back

Keterangan Tampilan :

Hasil evaluasi ini terdapat skor penilaian nilai benar dan nilai yang
salah serta score yang diperoleh

Keterangan Gambar, Animasi, Musik :
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Slide (Profil) Keterangan navigasi :

Tombol Pendahuluan : untuk
HEADER menuju frame Pendahuluan

Tombol Materi : untuk menuju
frame Materi

Biodata : Tombol Latihan : untuk menuju

/ \ frame Latihan

Tombol Evaluasi : untuk menuju
frame Evaluasi

FOTO

Tombol Profil : untuk menuju

K / frame Profil

Tombol Exit : untuk menuju frame

Exit
Profil
Pendahuluan Materi Latihan Evaluasi Profil
Keterangan Tampilan : Keterangan Gambar, Animasi, Musik :
Profil terdapat informasi pembuat media pembelajaran dan biodata
lengkap Gambar : Foto pembuat media pembelajaran

Animasi : Terdapat animasi masking pada foto dan animasi zoom out
pada informasi biodata.

Musik menggunakan instrument
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Slide (Exit) Keterangan navigasi :

Tombol Tidak : jika mengklik

tombok tidak maka akan kembali
Header ke menu utama

Tombol lya : jikan di klik akan

keluar
Apakah Kamu Benar Benar Ingin
Keluar?

Keterangan Tampilan : Keterangan Gambar, Animasi, Musik :

Tampilan frame exit, yang mana ada pernyataan mau keluar atau
melanjutkan ke menu utama




LAMPIRAN

3. Source Code
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Source Code Intro

//membuat new sound lagu

lagu = new Sound();

//memasukkan suara berlinkage suaraku ke dalam variable lagu
lagu.attachSound(''5");

//mainkan suara di dalam variable lagu sebanyak 999 kali
lagu.start(0, 999);

lagu.setVolume(30)

//ketika movie clip slider ditekan
slider.onPress = function() {

//membuat variable kanan dengan nilai koordinat x movie clip
garis yang ditambah 200

kanan = _root.garis._ X;

//membuat variable kiri dengan nilai koordinat x movie clip garis
kiri = _root.garis._X;

//membuat variable atas dengan nilai koordinat y movie clip garis
atas = _root.garis._y-200;

//membuat variable bawah dengan nilai koordinat y movie clip
garis

bawah = root.garis. y;

//movieclip ini bergerak mengikuti gerakan mouse dengan titik
pusat movieclip ini sebagai titik pusat gerakan

//batas gerakan Kiri moviclip ini adalah nilai dari variable Kiri
//batas gerakan atas moviclip ini adalah nilai dari variable atas

//batas gerakan kanan moviclip ini adalah nilai dari variable
kanan



bawah

¥

//batas gerakan bawah moviclip ini adalah nilai dari variable

startDrag(this, true, kiri, atas, kanan, bawah);

//ketika movie clip slider digerakkan

slider.onMouseMove = function() {

//membuat new object myPoint

myPoint = new Object();

//nilail x mypoint sama dengan koordinat x movie clip ini
myPoint.x = this._X;

//nilail y mypoint sama dengan koordinat y movie clip ini
myPoint.y = this._y;

_root.garis.globalToLocal (myPoint);

//nilai volume suara dalam variable lagu sama dengan nilai x

mypoint

¥

_root. lagu.setVolume(myPoint.y);
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//ketika tekanan pada movie clip slider dilepaskan ketika mouse bearda
di atasnya ataupun tidak

slider.onRelease = slider.onReleaseOutside=function () {

¥

//movie clip ini tidak dapat didrag

stopDrag();

Menghentikan Frame agar tidak loop (Mengulang terus)

stop();// untuk menghentikan animasi
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Membuat Full Screen

fscommand("fullscreen',true) // digunakan untuk Full Screen

Memanggil File Swf (Load Swf)
on (release) {
loadMovie("'MenuUtama.swf", 0);

} 7/ digunakan untuk memanggil MenuUtama.SwfF

Source Code Menu Utama
Suara Instrument

lagu = new Sound();
lagu.attachSound(*'3");
lagu.start(0, 999);

lagu.setVolume(80)

Tombol Next
on (release) {

nextFrame();

Tombol Stop

on (release) {

playQ
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Tombol Menu Utama untuk memanggil File .swf

on (release) { //
loadMovie("'Pengenalan.swf, 0);

}

Source Code Pengenalan

Suara Instrument

lagu = new Sound();

lagu.attachSound(''1'");

lagu.start(0, 999);

lagu.setVolume(50)

Tombol Pendahuluan
on (release) {

loadMovie("'Pendahuluan.swf", 0);

Tombol Materi
on (release) {

loadMovie("'Materi .swf'’, 0);

Tombol Latihan
on (release) {

loadMovie('Latihan.swf", 0);
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Tombol Evaluasi
on (release) {

loadMovie("'Kuis.swf'", 0);

Tombol Profil
on (release) {

loadMovie("'Profil.swf’, 0);

Tombol Keluar
on (release) {
loadMovie("'Konfirmasi Keluar.swf", 0);
}
Source Code Pendahuluan
Suara Instrument
lagu = new Sound();
lagu.attachSound('4');
lagu.start(0, 999);

lagu.setVolume(50)

Tombol Pendahuluan

on (release) {



loadMovie("'Pendahuluan.swf”, 0);

Tombol Materi
on (release) {

loadMovie(""Materi.swf’, 0);

Tombol Latihan

on (release) {

loadMovie("'Latihan.swf", 0);

Tombol Evaluasi
on (release) {

loadMovie("'Kuis.swf', 0);

Tombol Profil
on (release) {

loadMovie("'Profil._swf'", 0);

Tombol Keluar

on (release) {
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loadMovie("'Konfirmasi Keluar.swf", 0);

Source Code Materi
Tombol Materi 1
on (release){

gotoAndStop(68);

Tombol Materi 2
on (release){

gotoAndStop(99);

Tombol Materi 3
on (release){

gotoAndStop(109);

Tombol Materi 4
on (release){

gotoAndStop(128);
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Tombol Pendahuluan
on (release) {

loadMovie("'Pendahuluan.swf'", 0);

Tombol Materi
on (release) {

loadMovie("'Materi .swf'’, 0);

Tombol Latihan
on (release) {

loadMovie("'Latihan.swf", 0);

Tombol Evaluasi
on (release) {

loadMovie("'Kuis.swf', 0);

Tombol Profil
on (release) {

loadMovie("'Profil_swf'", 0);
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Tombol Keluar

on (release) {
loadMovie("'Konfirmasi Keluar.swf", 0);

}

Source Code Latihan

function Quizltem(question)

{
this.question=question;
this.answers=new Array();
this.picture=lokasi;

// reset statistic

this.numOfAnswers=0;

this.correctAnswer=0;

// this function returns the question of this item
this.getQuestion=function()
{

return this.question;

return this.lokasi;
}
// add answer to multiple choice items
this.addAnswer=function(answer, isCorrectAnswer)
{

this.answers[this.numOFfAnswers]=answer;

if (isCorrectAnswer)

this.correctAnswer=this.numOfAnswers;
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this.numOfAnswers++;

// this function returns the n-th answer
this.getAnswer=function(answerNumberToGet)

{

return this.answers[answerNumberToGet];

// this function returns the index of the correct answer
this.getCorrectAnswerNumber=function()

{

return this.correctAnswer;

// this function checks if the passed number is the
// correct answer index
this.checkAnswerNumber=function(userAnswerNumber)
{
if (userAnswerNumber==this.getCorrectAnswerNumber())
gotoAndPlay(*'Correct™);
else

gotoAndPlay("'Wrong™);



// this function parses the XML data into our data structure

function onQuizData(success)

{

var quizNode=this.firstChild;

var quizTitleNode=quizNode.FfirstChild;

title=quizTitleNode.firstChild.nodeValue;

var i=0;

// <items> follows <title>

var itemsNode=quizNode.childNodes[1];
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// go through every item and convert it into our data structure

while (itemsNode.childNodes[i])

{

var itemNode=itemsNode.childNodes[i];
// <item> consists of <question> and one or
// more <answer>.
// <question> always comes before <answer>s
// (le: <question> is the node 0 of <item>)
var questionNode=itemNode.childNodes|[0];

quizltems[i]=new

Quizltem(questionNode. FirstChild.nodeValue);

var a=1;

// Go through every answer and add them
// to our data structure.

// <answer> follows <question>

var answerNode=itemNode.childNodes[a++];
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while (answerNode)
{
var isCorrectAnswer=false;
if (answerNode.attributes.correct=="y")
isCorrectAnswer=true;
quizltems[i]-addAnswer(
answerNode.firstChild.nodeValue,
isCorrectAnswer);
// goto the next <answer>

answerNode=itemNode.childNodes[a++];

// We"re done decoding, now we can start
gotoAndStop(*'Start™);

}

var quizltems=new Array();

var myData=new XMLQ);

myData. ignoreWhite=true;

myData.onLoad=onQuizData;

myData. load("*latihan.xml™);

stop(); // 1°m telling Flash not to continue until the XML is
loaded.

Source Code Evaluasi

function Quizltem(question)



this.question=question;
this.answers=new Array();
this._picture=lokasi;

// reset statistic
this.numOfAnswers=0;

this.correctAnswer=0;

// this function returns the question of this item

this.getQuestion=function()
{

return this.question;

return this.lokasi;
}
// add answer to multiple choice items
this.addAnswer=function(answer, isCorrectAnswer)
{

this.answers[this.numOfAnswers]=answer;

if (isCorrectAnswer)

this.correctAnswer=this.numOfAnswers;

this.numOfAnswers++;

// this function returns the n-th answer

this.getAnswer=function(answerNumberToGet)

{
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return this._.answers[answerNumberToGet];

// this function returns the index of the correct answer
this.getCorrectAnswerNumber=function()

{

return this.correctAnswer;

// this function checks if the passed number is the
// correct answer index

this.checkAnswerNumber=function(userAnswerNumber)

{
if (userAnswerNumber==this.getCorrectAnswerNumber())
gotoAndPlay(*'Correct™);
else
gotoAndPlay(*'Wrong™);
}

// this function parses the XML data into our data structure
function onQuizData(success)
{

var quizNode=this.firstChild;

var quizTitleNode=quizNode.firstChild;

title=quizTitleNode.firstChild.nodeValue;
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var i1=0;

// <items> follows <title>

var itemsNode=quizNode.childNodes[1];

// go through every item and convert it into our data structure

while (itemsNode.childNodes[i])

{

var itemNode=i1temsNode.childNodes[i];
// <item> consists of <question> and one or
// more <answer>.
// <question> always comes before <answer>s
// (le: <question> is the node 0 of <item>)
var questionNode=itemNode.childNodes[0];
quizltems[i]=new
Quizltem(questionNode.firstChild.nodeValue);
var a=1;
// Go through every answer and add them
// to our data structure.
// <answer> follows <question>
var answerNode=itemNode.childNodes[a++];
while (answerNode)
{
var isCorrectAnswer=false;
if (answerNode.attributes.correct=="y"")
isCorrectAnswer=true;

quizltems[i].addAnswer(



}

answerNode.FirstChild.nodeValue,
isCorrectAnswer);
// goto the next <answer>

answerNode=itemNode.childNodes[a++];

// We"re done decoding, now we can start

gotoAndStop(*'Start™);

var quizltems=new Array();

var myData=new XML(Q);

myData. ighoreWhite=true;

myData.onLoad=onQuizData;

myData. load(*"latihan.xml™);

stopQ);

loaded.

Source Code Profil

Suara Instrument

lagu
lagu
lagu

lagu

= new Sound();
.attachSound("'2");
.start(0, 999);

-.setVolume(50)

Tombol Pendahuluan

// 1™m telling Flash not to continue until the XML is
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on (release) {

loadMovie("'Pendahuluan.swf'", 0);

Tombol Materi
on (release) {

loadMovie("'Materi .swf'’, 0);

Tombol Latihan

on (release) {
loadMovie('Latihan.swf", 0);

}

Tombol Evaluasi

on (release) {

loadMovie("'Kuis.swf", 0);

Tombol Profil
on (release) {

loadMovie("'Profil _swf"’, 0);

Tombol Keluar

on (release) {
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loadMovie("'Konfirmasi Keluar.swf", 0);

Source Code Exit
Tombol Tidak
on (release) {

loadMovie (“'menuutama.swf', 0);

}

Tombol lya
on (release) {

fscommand(*'quit', true);

}



LAMPIRAN

4. Instrumen Penelitian
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Kepada :

Yth. Bapak/Ibu Guru

Teknologi Informasi dan Komunikasi
SMA Negeri 1 Ngemplak

Di tempat

Assalamu’alaikum wr.wb.

Dalam rangka penyelesaian tugas Akhir Skripsi “Media Pembelajaran Microsoft
Excel Berbasis Multimedia Di SMA Negeri 1 Ngemplak” saya mohon dengan hormat

bapak/ibu guru untuk membantu dalam pengambilan data penelitian.

Angket ini murni keperluan studi, sama sekali tidak ada hubungannya dengan
kredibilitas lembaga (sekolah) maupun guru. Sehingga saya mohon dengan segala hormat
angket ini dapat diisi sesuai dengan kondisi yang sebenarnya. Demikian permohonan saya,

atas kerjasamanya saya ucapkan terima kasih.
Wassalamu’alaikum wr.wb.
Peneliti,

/ﬂ/—

Agus Buchori
NIM. 07520244036
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SURAT PERMOHONAN VALIDASI

Kepada
Yth. Ibu Suhartati, ST
Di tempat.
Yang bertanda tangan dibawah ini:
Nama : Agus Buchori
NIM : 07520244036
Jurusan : Pendidikan Teknik Elektronika
Prodi : Pendidikan Teknik Informatika

Dengan ini, saya mengajukan permohonan kepada Bapak untuk mengadakan validasi
terhadap angket penelitian dalam skripsi saya yang berjudul “Media Pembelajaran
Microsoft Excel Berbasis Multimedia”

Demikian permohonan saya, atas terkabulnya permohonan tersebut saya ucapkan
terimakasih.

Yogyakarta, \‘&M“\QOU .....

Mengetahui,
Dosen Pembimbing Hormat saya,
/\_. <
Drs. Kadarisman Tejo Yuwono Agus Buchori

NIP. 19600505 198702 1 001 NIM. 07520244036



Instrumen Penelitian

LEMBAR OBSERVASI AHLI MATERI

Berilah tanda cek (V) pada kolom yang tersedia sesuai dengan pendapat Saudara
terhadap setiap pernyataan tentang Media Pembelajaran Pengenalan Dasar
Komputer Berbasis Multimedia. Sebelum dan sesudahnya kami ucapkan terima
kasih.

Keterangan:
4 : Sangat Setuju
3 : Setuju
2 : Kurang Setuju
1 : Tidak Setuju
Aspek Penilaian
Skor
No Pernyataan
ES 3 2 1
1. | Media ini sudah terdapat pengenalan 7
tentang Microsoft Excel
Media ini sudah terdapat pengenalan
2. | berbagai menu dalam Microsoft V4
Excel

3. | Media ini sudah menjelaskan fungsi
dari masing-masing ikon

4. | Media ini sudah terdapat tutorial
untuk membuat lembar kerja

Media ini sudah terdapat penjelasan
5. | cara mengolah data dalam lembar
kerja

| <=

6. | Media ini sudah menjelaskan rumus
dasar pada Microsoft Excel

7 | Media ini terdapat penjelasan untuk
menyisipkan gambar lembar kerja

Media ini sudah terdapat penjelaskan
8 | untuk menyisipkan grafik dalam
lembar kerja

<
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SURAT KETERANGAN VALIDASI

Yang bertanda tangan dibawah ini :
Nama + : Suhartati, ST

Telah membaca instrumen dalam skripsi yang berjudul “Media Pembelajaran Microsoft
Excel Berbasis Multimedia” yang disusun oleh :

Nama : Agus Buchori
NIM : 07520244036
Jurusan : Pendidikan Teknik Elektronika
Prodi : Pendidikan Teknik Informatika

Setelah memperhatikan butir-butir soal yang ada dalam instrument tersebut maka masukan

untuk peneliti adalah :
\. Dada Wagten 1 (tbqn‘kh?’m antara 3thm" dan tg,-ktfqmﬂqm a“[ﬁ‘hkkﬂ{b—}

..........................................................................................................

Demikian keterangan ini dibuat agar digunakan sebagaimana mestinya.

Yogyakarta, {4 WMet 2010
Validator,

Wﬁ

-

Suhartati, ST
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SURAT PERMOHONAN VALIDASI

Kepada
Yth. Herman Dwi Surjono, Ph.D
Di tempat.

Yang bertanda tangan dibawah ini:

Nama : Agus Buchori
NIM : 07520144036
Jurusan : Pendidikan Teknik Elektronika
Prodi : Pendidikan Teknik Informatika

Dengan ini, saya mengajukan permohonan kepada Bapak untuk mengadakan validasi
terhadap angket penelitian dalam skripsi saya yang berjudul “Media Pembelajaran
Microsoft Excel Berbasis Multimedia Di SMA Negeri 1 Ngemplak”.

Demikian permohonan saya, atas terkabulnya permohonan tersebut saya ucapkan

terimakasih.

Mengetahui, Hormat saya,

Dosen Pembimbing

/\,

Drs. Kadarisman 1.Y Agus Buchori
NIP. 19600505 198702 1 001 NIM: 07520244036



Berilah tanda cek (V) pada kolom yang tersedia sesuai dengan pendapat
Bapak/Ibu/Saudara terhadap setiap pernyataan tentang Media Pembelajaran
Microsoft Excel Berbasis Multimedia. Sebelum dan sesudahnya kami ucapkan

Instrumen Penelitian

LEMBAR OBSERVASI AHLI MEDIA PEMBELAJARAN

terima kasih.
Keterangan:
4 : Sangat Setuju
3 : Setuju
2 : Kurang Setuju
1 : Tidak Setuju
Aspek Penilaian
Skor
No Pernyataan
1. | Pemilihan font sudah tepat
2. | Komposisi warna menarik
3. | Kualitas gambar bagus
4. | Letak button (tombol back, next,

home, exit, scrollbar) konsisten

LIS = =R RR] e

5. | Penggunaan warna konsisten

6. | Pemilihan font konsisten

7. | Tombol (back next, home, exit,
scrollbar) sudah berfungsi dengan
baik

8. | Link sudah berfungsi dengan baik

9. |Media pembelajaran membantu
belajar dengan fokus

10. | Media pembelajaran mempermudah

praktek Microsoft Excel
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SURAT KETERANGAN VALIDASI

Yang bertanda tangan dibawah ini :
Nama : Herman Dwi Surjono, Ph.D
NIP : 19640205 198803 1 001
Telah membaca instrumen dalam skripsi yang berjudul “Media Pembelajaran

Microsoft Excel Berbasis Multimedia” yang disusun oleh :

Nama : Agus Buchori
NIM 107520244036
Jurusan : Pendidikan Teknik Elektronika
Prodi : Pendidikan Teknik Informatika

Setelah memperhatikan butir-butir soal yang ada dalam instrument tersebut maka

masukan untuk peneliti adalah :

— Majen rF/v\. B-mﬁU-rﬂ no ‘e\«ﬂ-ﬂa/w\..«v-«,

Demikian keterangan ini dibuat agar digunakan sebagaimana mestinya.

Yogyakarta, {8 Mz 201

lidator,

Herman Dwi Surjono, Ph.D
NIP. 19640205 198803 1 001
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Berilah tanda cek (V) pada kolom yang tersedia sesuai dengan pendapat Saudara
terhadap setiap pernyataan tentang Media Pembelajaran Pengenalan Dasar
Komputer Berbasis Multimedia. Sebelum dan sesudahnya kami ucapkan terima

Instrumen Penelitian

LEMBAR OBSERVASI SISWA

kasih.

Keterangan:
4 : Sangat Setuju
3 : Setuju
2 : Kurang Setuju
1 : Tidak Setuju

e e e

Nama responden

Kelas

No Absen

No

Pernyataan

Skor

Media ini membantu pemahaman
tentang fungsi masing-masing ikon
dalam Ms. Excel

Media ini membantu  untuk
mempermudah membuat lembar
kerja dalam Ms. Excel

Media ini membantu pemahaman
tantang penggunaan rumus-Tumus
dasar dalam Ms. Excel.

Media ini mempermudah langkah
untuk menyisipkan gambar pada
lembar kerja Ms. Excel.

Media ini mempermudah langkah

untuk menyisipkan grafik pada
lembar kerja Ms. Excel

Media ini menggunakan font yang
sudah tepat

Media ini menggunakan warna-warna
yang seimbang

Media ini disisipi gambar yang
mampu memperjelas materi tentang
Ms.Excel.
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Media ini mempunyai tombol-tombol

o yang letaknya konsisten v

10 Media ini mempunyai tombol-tombol v
" | yang berfungsi dengan benar

1 Media ini mempunyai fasilitas link v
" | yang berfungsi dengan benar.

12 Media ini membantu lebih fokus Vs
" | dalam belajar Ms. Excel

13 Media ini mempermudah praktik Ms. vV

Excel
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LAMPIRAN

5. Data Penelitian



VALIDITAS INSTRUMEN

Jawaban Angket Total
Nomor Nama Responden Total Kuada
Responden 1 2 3 4 5 6 7 8 9 10 11 12 13 rat

1 Rosita Carolin 3 4 2 2 3 4 2 1 4 4 3 4 4 40 1600
2 Septiana Krisnawati 3 4 3 3 3 3 2 4 4 4 3 4 4 44 1936
3 Tri Apsari Rachmah 3 3 3 3 3 3 2 2 1 3 3 4 4 37 1369
4 Yoga Pradana 3 3 3 3 3 1 2 2 4 4 4 3 3 38 1444
5 Rini Setiani 3 3 3 3 3 3 2 3 1 3 2 1 3 33 1089
6 Risa Eka Putri 4 4 4 4 4 3 3 4 4 4 4 4 4 50 2500
7 Tanu Honggonegoro 4 4 4 4 4 4 3 4 3 4 4 4 4 50 2500
8 Intan Ramona F 3 3 3 3 3 4 4 4 4 4 4 3 3 45 2025
9 Retno Putri Astuti 3 3 3 3 3 4 4 4 4 4 4 3 3 45 2025
10 Sabela Wibowo 3 3 3 3 3 4 4 3 3 4 3 4 4 44 1936
11 Tri Widiasari 3 4 3 3 3 4 4 3 4 4 3 3 4 45 2025
12 Wisnu Aji W A 4 3 3 3 3 2 3 3 2 2 3 3 3 37 1369
13 Yogie Patradinata 3 3 3 3 3 2 2 3 2 4 3 4 3 38 1444
14 Riyan Asmara T P 4 4 4 3 3 1 3 3 3 3 3 2 4 40 1600
15 Riyanto Wahyudhi 4 4 4 4 4 4 3 4 4 4 4 4 4 51 2601
16 Sefi Rukmanasari 3 3 3 3 3 3 3 3 4 3 3 2 3 39 1521
17 Sry Wijayanti 4 4 4 3 3 2 3 4 4 4 4 3 3 45 2025
18 Tri Astuti 3 3 3 3 3 2 2 3 4 3 4 3 3 39 1521
19 Wahyu Laksono P 3 4 3 3 3 3 2 3 3 4 4 4 3 42 1764
EX 63 66 61 59 60 56 53 60 62 69 65 62 66

Ex? 213 234 201 187 | 192 184 159 202 | 222 257 229 216 234

EXY 2679 | 2813 | 2602 | 2517 | 2557 | 2411 | 2274 | 2581 | 2672 | 2946 | 2778 | 2657 2807

EY 802

EY2 34294
rxy 0.464 | 0.593 | 0.569 0.65| 0.73 | 0.516 | 0.525 | 0.651 | 0.59 | 0.629 | 0.634 | 0.514 | 0.461689

Ket Valid | Valid | Valid | Valid | Valid | Valid | Valid | Valid | Valid | Valid | Valid | Valid Valid

r tabel n:19 = 0,456
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REALIBILITAS INSTRUMEN
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Jawaban Angket Jmih
NoO Nama Responden Total Kiig:at ve:)r;erm Varian
Res 1 2 3 4 5 6 7 8 9 10 11 12 13 Total item total
1 Rosita Carolin 3 4 2 2 3 4 2 1 4 4 3 4 4 40 1600
2 | Septiana K 3 4 3 3 3 3 2 4 4 4 3 4 4 44 1936
3 | TriApsari R 3 3 3 3 3 3 2 2 1 3 3 4 4 37 1369
4 | Yoga Pradana 3 3 3 3 3 1 2 2 4 4 4 3 3 38 1444
5 | Rini Setiani 3 3 3 3 3 3 2 3 1 3 2 1 3 33 1089
6 | Risa Eka Putri 4 4 4 4 4 3 3 4 4 4 4 4 4 50 2500
7 | TanuH 4 4 4 4 4 4 3 4 3 4 4 4 4 50 2500
8 | Intan Ramona F 3 3 3 3 3 4 4 4 4 4 4 3 3 45 2025
9 | Retno Putri Astuti 3 3 3 3 3 4 4 4 4 4 4 3 3 45 2025
10 | Sabela Wibowo 3 3 3 3 3 4 4 3 3 4 3 4 4 44 1936
11 | Tri Widiasari 3 4 3 3 3 4 4 3 4 4 3 3 4 45 2025
12 | Wisnu Aji WA 4 3 3 3 3 2 3 3 2 2 3 3 3 37 1369
13 | Yogie Patradinata 3 3 3 3 3 2 2 3 2 4 3 4 3 38 1444
14 | Riyan Asmara T P 4 4 4 3 3 1 3 3 3 3 3 2 4 40 1600
15 | Riyanto Wahyudhi 4 4 4 4 4 4 3 4 4 4 4 4 4 51 2601
16 | SefiR 3 3 3 3 3 3 3 3 4 3 3 2 3 39 1521
17 | Sry Wijayanti 4 4 4 3 3 2 3 4 4 4 4 3 3 45 2025
18 | Tri Astuti 3 3 3 3 3 2 2 3 4 3 4 3 3 39 1521
19 | WahyuL P 3 4 3 3 3 3 2 3 3 4 4 4 3 42 1764
Jumlah 63 66 61 59 60 56 53 60 62 69 65 62 66 | 802 | 34294
3 Kuz|adrat 213 234 201 187 192 184 159 202 | 222 257 229 | 216 234
Varian per item 0.216 | 0.249 | 0.271 1 0.199 | 0.133 | 0.997 | 0.587 | 0.659 | 1.36 | 0.338 | 0.349 | 0.72 | 0.249 6.554 | 23.2188

Rumus Alpha
0.803129281




Data Uji Coba lapangan

145

No Res Nama Jawaban responden item no : Jumlah
Siswa 1/2|3/4(5/6|7|8|9|10(11 12|13
1 Angga Armania P 414131413 (3(3|3(3| 4 3| 4] 4 45
2 Apridita SW 313(3(4(3(4|3|3(3] 3| 4| 4| 3 43
3 Bihenikson Damanik Limbong (4|3 (4|3 |3 (4 (4|3|4| 4| 4| 3| 3 46
4 Desi Wulandari 41313333233 3] 3| 3| 2 38
5 Desty Damaviana 314|13(3(3(2(2|4/4] 4| 4| 4| 4 44
6 Dwi Kurniawan 313(4(3(4(3(3|3|4| 4] 4] 4] 4 46
7 Dwi Murwani 313(3(3(3(4|4|3(3] 3| 3| 4| 4 43
8 Figdyawati Haningtia 3(3(4(4(4(3(3/2,3| 3| 3| 3| 3 41
9 Fitriana 4(41413|3|3(2(3|3| 3| 3| 3| 3 41
10 Intan Pangestu 314(4(4(4(3|13|13|14) 3| 3| 4] 4 46
11 Luthfiana Eka Putri 314(3(4(3|3|4|4(4] 3| 3| 3| 4 45
12 M Berlian 3|13(3(4(4|4|3|4(3] 4] 4] 3| 3 45
13 M Maskur 4(413|3|3|4(3|4|3| 4| 4] 3| 3 45
14 Nia Wahyu P 4(3(3|4|4|3|3[4|3| 3| 3| 4] 3 44
15 Novi Eka Putri 3(3(2(3|3[3|3(4/4| 4| 3| 4| 3 42
16 Nurmita Wahyu P 413|13|3(3(4(4|4(3| 4] 3| 4] 3 45
17 Paham Winarsis 41312334 |3(4(4| 3| 3| 4| 4 44
18 Rosamita 313(3(3(3(2(3/3,4| 4| 4| 3| 3 41
19 Adelisa Isti Farida 41414144323 (3| 3| 3| 3| 4 44
20 Anggraheni Noormalita Sari 3(3(3(3|3|4|4(4(3| 3| 3| 4| 4 44
21 Argentina Welly S B 3(3(3(3|3(2|4(4/3| 3| 3| 4| 3 41
22 Ariana Rusbiyati 313(3(3(3(2|4|4(4] 4] 4| 3| 2 42
23 Bondan Probo Setya Y 413|3(3(4(3(2|3(4| 4] 4| 3| 2 42
24 Dwi Yuliani 314(3(3(3(4|4(4(3] 3| 3| 2| 3 42
25 Dwinita Putri Wulandari 313(2(3(3(2|2|3(3] 2| 4| 4| 3 37
26 Fatmawati 3|13(4(3(4|3|3(4(4] 4] 4] 3| 3 45
27 Herni Vitasari 313(3(3(3(4|2|3(3] 4] 4| 3| 3 41
28 Herpin Mirana 314(3(4(4(3(2/3,4| 3| 4| 3| 3 43
29 Yonatan Eko A 4(3(3(4|4|3(2(4|3| 4| 4] 3| 3 44
30 Kartika Anggarawati 313|13(4(3(3(4|4,4] 3| 3| 3| 4 44
31 M Fairus R.R 4141414413 |3(44| 4| 4| 4| 4 50
32 Nenti Yuli M 4(3(3(3|3|4(4(3|4| 4| 4] 3| 3 45
33 Niga Nur Laili 3|13(3(3(3(4|4(4(3| 3| 3| 4| 4 44
34 Rahmat Saiful Ratta 314(4(3(3(3|3(4(3] 3| 3| 4| 2 42
35 Ratih Anggraeni 3|13(3(3(4(4|2|4(3| 3| 4| 4| 4 44
36 Riega Dananjaya 4131112124313 [3]| 4| 3 1| 2 35
37 Alfi Nurhayati 4(41413|3|2(3[4|3| 4| 4] 2| 3 43
38 Ariningsih 4(3(1(2|2|4(3|3|3| 4| 3| 1] 3 36
39 Ary herdianto 4141413 |3|2(3|4|3| 4| 4] 2| 3 43
40 Arya bhayangkara putra 313(3(3(3(2|3|1(3] 3| 3| 4| 4 38
41 Atika yusnia wati 4(3(414|3|3|3(4|4| 4| 4| 4| 4 48
42 Chendy putriana 4141433 |3|3(44| 4| 4| 4| 4 48
43 Dewi wahyu tri utami 3/3(3(4(4(3(3/4,4| 3| 4| 4| 3 45
44 Endah retno wulandari 4(4(4,3|3|4(4(3|4| 3| 4| 4] 3 47
45 Erni septianti 313(3(3(4(3(4|1414) 4] 4] 3| 4 46
46 Erni setia nengsih 4141343444 (3| 3| 4] 3| 4 47
47 Fitri solekah 3(4(3(3|4(3|3(3/4| 4| 4| 4| 3 45
48 Hardianto 3(4(3(3|3[4|3(4/3| 4| 4| 4| 3 45
49 Hendi prasetyo 413|13(3(4(4|3|3(3| 3| 3| 4| 4 44
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50 Ika sagita damayanti 413|3|3(4|4(2|4(4)| 4] 4| 3| 3 45
51 Imadudin 4141343 |3|3(4|4| 4| 4| 4| 4 48
52 M arya wresniwira 4144|334 (3(4(4| 3| 2| 4| 3 45
53 Novi yuzi astuti 4143342434 3| 3| 4| 4 45
54 Nur sya‘'adah 314(3(2(4|3|3|4(4] 3| 4| 4] 3 44
55 Nurul dwi wahyuni 314(3(3(3(2|2|3(3| 3| 3| 4| 4 40
56 Pandji saputra 4134344244 4| 3| 4| 3 46
57 Pindi ardani 4(3(414|3|3|3(4|4| 4| 4| 4| 4 48
58 Alifah Nur Setyowati 4(4(4/3|3|4|3(4/3| 3| 3| 4| 4 46
59 Anindya Septiana Putri 414141333344 4| 4| 4| 4 48
60 Ari Aryana 41414344244 3| 4| 4| 4 48
61 Ari Restuningtias Timur 3(3(4(3(3(3(4,4,4| 4| 4| 4| 3 46
62 Bernadus Kuncahyo Hadi 4141434424 (4| 3| 4| 4| 4 48
63 Dewi Andriana 3(3(4(3|4/3|4/2|3| 3| 4| 3| 3 42
64 Dimas Arga Praditya S 3(4(4(4)13[3|3(3/4| 4| 3| 3| 3 44
65 Febriana Ika Rahmadhani 414134414 |13(3|3| 3| 4| 4| 4 47
66 Galuh Tika Indria Pratiwi 313(3(3(3(4|4|2(3] 3] 3| 3| 3 40
67 Galuh Tri Muldya Astuti 4(413(3(3|2|3(3|4| 4| 4| 4| 4 45
68 Heru Dwi Apriyanal 313(3(4(4|3|3|4(4] 3| 3| 4| 4 45
69 Hesty Widarti 313(3(4(4(4|12|3(3] 3| 3| 4| 4 43
70 Hur Huda 313(3(3(3(2|2|3(3] 3| 3| 4| 4 39
71 Mirnantika Nurhanafi 4(3(3/4(3|3|3(3[3| 3| 3| 4| 4 43
72 Muhamad Mahfud Sahal 4(413(3|3|3(4(4|3| 3| 3| 3| 3 43
73 Naimi Hajar Subekti 4(413(3(3|3|3(44| 4| 4| 4| 4 47
74 Nur Nugraheni 4144|433 (3(3(4| 4| 3| 3| 3 45
75 Pangestuti Alfiana Dewi 3/3(4(4(4(3(3/3,/3| 4| 4| 3| 3 44
76 Paulus Yuan Abilawa 41414144443 (3| 3| 4| 4| 4 49
77 Revita Rianindya Christina 3(3(3(3|4/4|13(3/3| 3| 3| 3| 3 41
78 Rifgi Nurfitriantoro 3|13(3(3(4|4|4|4(4] 3| 3| 4| 4 46
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Revisi dari Ahli Materi

1. Penyajian materi sebaiknya disejajarkan agar siswa mempelajarinya lebih mudah
a. Sebelum direvisi

# Materi
Fille View Contral Debug

-+ Anda berada di menu Materi 1 > Menu .
Menu Pada Microsoft Excel (Menu File)

W 1. New, untuk menampilkan atau membuat lembar kerja baru =

2.0pen, untuk membuka file dari lembar kerja yang telah disimpan

dilomputer atau media lam

13.Save, menyimpan lembar kerja yang telah dibuat

4.Save As, untuk menyimpan hasil pekerjaan dengan nama yang
berbeda

5.5ave as Web Page uvntuk menyimmpan hasil pekerjaan untuk
kepertuan web di mternet

6.Page Setup untuk mengatur tata letale halaman dari lembar kerja
vang telah kita buat

Lihat
-l

# Materi
Fille View Contral Debug

i . Anda berada di menu Materi 1> Menu :.
(o ik e jmt Fomot Teok Dwa ¥ .
amm | Menu Pada Microsoft Excel (Menu File)

L} tew...
J‘ o =
=

Il sve Qs
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b. Sesudah direvisi

# Materi

Flle Yiew Control Debug

Wy w

-1 Anda berada di menu Materi 1 > Menu :.
Formst ook [ata ¥

-:uﬁl Menu Pada Microsoft Excel (Menu File)

| Ede | fot
—_— ghe 1. New, untuk menampilkan atau membuat *

il 500 @5 | llembar kerja baru
Seve bz,

| 2.0pen, untuk membuka file dari lembar
S Srum e s Pagn. |

A kerja vang telah disunpan dikomputer atau
Y e Seueh - | jmecha lamn
f— 5

| [3.Save, menyimpan lembar kerja yang

:::::Tw | [telah dibuat
Prek rea o [4.8ave  As,  untuk  menyinpan  hasil
[y X Brutew pekerjaan dengan nama vang berbeda
. ::h aw.' 5.8ave as Web Page wntuk menymnpan
Proparies hasil pekerjaan vntuk keperduan web di

| 1 owalosdelaT_t{erl) internet
1 6.Page Setup untuk mengatur tata letak

2 Bookt
Ve | halaman dari lembar kerja yang telah kita | )
3 1 v ') 4
1 | L4

2. Pada kuis diberikan tombol kembali
a. Sebelum direvisi

 Adobe Flash Player 9
Yiew Control Help

Pada Microsoft Excel, area kerja pada program tersebut disebut sebagai...

A Worksheet

B Workbook

C Slide
D Panel
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b. Sesudah direvisi

File View Control Debug

Pada Microsoft Excel, area kerja pada program tersebut disebut sebagai...

A Worksheet

B Workbook

C Slide
D Panel
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Revisi dari Ahli Media
1. Materi perlu diberikan halaman
a. Sebelum direvisi

. Anda berada di menu Materi 1 > Pendahuluan :.

Microsoft Excel adalah General Purpose Electronic Spreadsheet yang
bekerja dibawah Sistem Operasi Windows. Microsoft Excel dapat
digunakan untuk menghitung angka-angka, bekerja dengan daftar
data, dan menganalisa data-data serta mempresentasikannya ke dalam
bentuk grafik/diagram.

: Anda berada di menu Materi 1> Pendahuluan = Hal 1.1.1

Microsoft Excel adalah General Purpose Electronic Spreadsheet yang
bekerja dibawah Sistem Operasi Windows. Microsoft Excel dapat
digunakan untuk menghitung angka-angka, bekerja dengan daftar
data, dan menganalisa data-data serta mempresentasikannya ke dalam
bentuk grafik/diagram.




2. Scrolling sebaiknya dihindarkan
a. Sebelum direvisi
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: Anda berada di menu Materi 3> Pemformatan :.

Fungsi Kelompok Text

teks

menjadi hurof keeil.

Contoh : =LOWER(*SAYA”) menghasilkan saya

6. Proper : mengubah karakter pertama dalam setiap kata yang ada pada suat
teks

mengadi huruf besar / kapital dan mengubah huruf berkutnya dengan huru
kecil.

Contoh : =PROPER(“saya sedang praktikum”) menghasillkan Saya Sedan
Praktikum

7. Len : mengambil karakter terkini sepunlah yang dinyatakan pada argumen
jumlah_karakter.

Contoh : =UPPER(“Praktikum’™) menghasilkan 9

- Anda berada di menu Materi 3 > Fungsi . Hal 3.2.3

Fungsi Kelompok Text

1. Left : mengambil karakter yang ada di sebelah kiri dari satu kesatuan
karakter.

Penulisan : =LEFT(teks, jumlah_karakter)

2. Right : mengambil karakter yang ada di sebelah kanan dari satu kesatuan
karakter.

Sistem Informasi UKDW 2005 - Tutorial Microsoft Excel 10/16

Penulisan : =RIGHT (teks, jumlah karakter)

3. Mid : mengambil karakter yang ada di tengah dari satu kesatuan karakter.
Penulisan : =MID(teks, angka awal, jumlah karakter)

4. Upper : mengubah semua karakter dalam setiap kata yang ada pada suatu
teks menjadi huruf besar / kapital.

Contoh : =UPPER(*saya”) menghasilkan SAYA
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3. Menampilakan Pull-down menu sebaiknya dibuat animasi atau pop-up, agar tidak seperti
buku

a. Sebelum direvisi

Fle WView Conbrol Help

- Amda berada di menu Materi 2 > Pemformatan

Perintah untuk Pemformatan Worksheet
Format | Tools  Data  Window iU Hegh...

5 cels.. Chrl1 AuoFt

Row » tide

Senmya ot st e
ot s,

Column »

Sheet 3

AutoFormat. .

Congitional Formatting. ..

tyle...

Tab Cokory o

Klik gambar untuk menampilkan penjelasan gambar ini

T Lampiran R. .. B MED

istart, @ g © 7 bie

b. Sesudah direvisi

% Adobe Flash Player 9
Fle WView Conbrol Help
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4. Latihan sebaiknya diarahkan pada pencapaian Kompetensi Dasar

a.

b.

Sebelum direvisi

Berikut merupakan fungsi dari program pengolah angka, kecuali...

A Untuk mengolah lembar kerja

B Untuk melakukan perhitungan f

y.

C Untuk membuat database

D Untuk mengelola gambar

Sesudah direvisi

% hdobe Flash Player 9

File View Control Help

Menu-menu yang terdapat pada Microsoft Excel adalah , kecuali...

A Undo
B Print

C Preview

D Slide Show

“ r. MEDIA PEMBELAJA...
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